# Contents

*About This Book* ................................................. v
*What’s New in SAS Studio 5.1* .............................. vii

## Chapter 1 • Introduction to SAS Studio

- About SAS Studio ............................................... 1
- Using SAS Studio .............................................. 2

## Chapter 2 • Working with Programs

- About the Code Editor .......................................... 17
- Opening and Creating Programs ............................... 18
- Working with Code Snippets ................................... 29
- Customizing the Code Editor ................................... 39

## Chapter 3 • Working with Data

- About the Table Viewer ......................................... 41
- Opening and Viewing Data ..................................... 43
- Viewing the Code That Is Used to Create a Table .......... 45
- Opening Data in a Task from the Table Viewer ............. 46
- Refreshing Your Data ........................................ 47
- Freezing and Sorting Data ..................................... 47
- Filtering Data ................................................ 48
- Exporting Data ............................................... 50

## Chapter 4 • Working with Results

- Viewing Results ................................................ 51
- Default SAS Studio Output .................................... 51
- About the SAS Output Delivery System .................... 52
- About SAS ODS Statistical Graphics ....................... 53

## Chapter 5 • Understanding Tasks in SAS Studio

- What Is a Task? ................................................ 55
- How to Run a Task ............................................ 55
- Edit a Predefined Task ......................................... 56
- Create a New Task ............................................ 57
- Specifying the Options for the Task Code .................. 58

## Appendix 1 • Customizing SAS Studio

- About Customizing SAS Studio ............................... 59
- Creating Global Settings ...................................... 59
- Setting Your Preferences ....................................... 61

## Appendix 2 • Text Encoding Options and Language Mappings

- About the Text Encoding to Language Mappings .......... 71
- Text Encoding Options and Language Mappings .......... 71

## Appendix 3 • Customized Output Environment

- Overview ....................................................... 73
- Generate Output for Other Output Destinations .......... 74
- Send Your Results to Another Location .................... 74
Use a Custom Style for Your Output ................................................. 75
Use an Image Format Other Than the Default .................................... 75
Create a Drill-down Graph .............................................................. 75
Create an Animated GIF or SVG Image ............................................ 76

Appendix 4 • Keyboard Shortcuts ..................................................... 77
Keyboard Shortcuts in SAS Studio Workspace ................................ 77
Keyboard Shortcuts for the Code Editor ........................................... 79
Keyboard Shortcuts for the Expression Builder ................................. 83

Recommended Reading ............................................................... 85
Index ......................................................................................... 87
About This Book

Audience

This book is designed for all users of SAS Studio. SAS Studio was initially released with the first maintenance release for SAS 9.4. SAS Studio 5.1 is the latest release.
Overview

SAS Studio 5.1 includes these new features and enhancements:

• updated user interface. For more information, see “Updated User Interface” on page vii.

• ability to access snippets with abbreviations. For more information, see “Create Snippet Abbreviations” on page vii.

• ability to view a list of all open files in your current SAS Studio session. For more information, see “New Open Files Section in Navigation Pane” on page viii.

• new filtering and column features in the table viewer. For more information, see “New Advanced Filtering and Column Features in the Table Viewer” on page viii.

• new Submission Status window. For more information, see “New Submission Status Window” on page viii.

• Interactive perspective. For more information, see “Interactive Perspective” on page viii.

• new Console window. For more information, see “New Console Window to View Messages” on page ix.

• new and enhanced tasks for SAS Viya. For more information, see “SAS Studio Tasks” on page ix.

Updated User Interface

SAS Studio 5.1 has been rewritten using the OpenUI5 framework. SAS Studio 5.1 uses the SAS Viya Compute Server and a common microservices code base instead of the SAS 9 workspace server.

Create Snippet Abbreviations

You can create abbreviations for snippets in your My Snippets folders in order to quickly add them to a program. For information about creating snippets, see “Create a Code
New Open Files Section in Navigation Pane

In SAS Studio 5.1, you can quickly view and access all of the files that are open in your current SAS Studio session. You can also use the Open Files section to save any unsaved changes to all of the files in the list. For more information, see “Using the Navigation Pane” on page 3.

New Advanced Filtering and Column Features in the Table Viewer

In SAS Studio 5.1, you can filter data in the table viewer by creating advanced filter expressions with the expression builder. You can use just one column in a filter, or you can use multiple columns to create several comparison expressions. If you create more than one comparison expression in your filter, you can specify whether the relationship between the filter elements is AND or OR. For more information, see “Filtering Data” on page 48.

You can freeze the data in the table at a specified column and continue to scroll through the remaining columns. For more information, see “Freezing and Sorting Data” on page 47.

New Submission Status Window

SAS Studio 5.1 includes a Submission Status window that displays information about the programs and tasks that you run. You can also cancel a running program or task. For more information, see “Using the Submission Status Window” on page 12.

Interactive Perspective

The new Interactive perspective replaces the interactive mode and is designed to help you run interactive SAS procedures. In the Interactive perspective, SAS Studio does not add any automatically generated code. In addition, the log and results are appended to any existing log and results, and previously submitted code remains active until you terminate it. For more information, see “Understanding Perspectives” on page 13.
New Console Window to View Messages

The Console window displays all of the messages, such as error messages and warnings, that are generated as you run programs and tasks. You can filter the list of messages to display only specified message types. For more information, see “Using the Console” on page 11.

SAS Studio Tasks

The tasks that are shipped with SAS Studio are documented in SAS Studio: Task Reference Guide. All of the tasks that are available with SAS Studio are documented. However, the tasks that are available at your site depend on whether you license and install other SAS products.

New Task Console

For each task, the Task Console displays any options or role assignments that are required to run the task. The console makes it easier for you to identify and find any missing information. Simply click an error in the console to view the required option in the task interface. You can quickly provide the missing information and run the task.

Graph Tasks

In the Line Chart task, you can now include error bars in the chart when you calculate the mean of a variable. For more information, see “Line Chart” in SAS Studio: Task Reference Guide.

SAS Viya Evaluate and Implement

The new Register task imports an analytic model from an analytic object in a CAS table into SAS Model Manager. Once in SAS Model Manager, you can score new data with the model, compare the model with other models, and publish the model to a production system. For more information, see “SAS Viya: Register” in SAS Studio: Task Reference Guide.

SAS Viya Supervised Learning

- The new Bayesian Network task trains a predictive model of a nominal target using different types of Bayesian network structures, including naive, tree-augmented naive, Bayesian network-augmented naive, parent-child Bayesian network, and Markov blanket. Automatic selection of the best parameters using a validation data subset is available. For more information, see “SAS Viya: Bayesian Network” in SAS Studio: Task Reference Guide.

- In the Neural Network task, you can now specify up to 10 hidden layers. In the Code Generation options, you can use the NNET procedure or the CAS procedure to run
the task. For more information, see “SAS Viya: Neural Network” in SAS Studio: Task Reference Guide.

- In the Decision Tree task, the default value for the **Maximum depth of a tree** option is 10. In the Code Generation options, you can now use the TREESPLIT procedure to run the task. For more information, see “SAS Viya: Decision Tree” in SAS Studio: Task Reference Guide.

### SAS Viya Text Analytics

- The Segmentation task segments text data using **k-means clustering**. For more information, see “SAS Viya: Segmentation” in SAS Studio: Task Reference Guide.

- The Text Scoring task scores a data table using tables generated by another text analytics task. For more information, see “SAS Viya: Text Scoring” in SAS Studio: Task Reference Guide.

- In the Text Parsing and Discovery task, the **Latent Dirichlet allocation (LDA)** model is now available if you license and install SAS Visual Text Analytics. For more information, see “SAS Viya: Text Parsing and Topic Discovery” in SAS Studio: Task Reference Guide.

### SAS Viya Network Analysis and Optimization

The new Summary Statistics task calculates various summary statistics for a graph and its nodes. For more information, see “SAS Viya: Summary” in SAS Studio: Task Reference Guide.

### SAS Viya Econometrics


- The new Spatial Regression Models task analyzes a class of linear spatial econometric models for cross-sectional data with observations that are spatially referenced or georeferenced. For more information, see “SAS Viya: Spatial Regression Models” in SAS Studio: Task Reference Guide.

- The new Hidden Markov Models task analyzes the same time series or panel data by using a statistical Markov model to infer hidden states through a Markov process. For more information, see “SAS Viya: Hidden Markov Models” in SAS Studio: Task Reference Guide.

- The Severity Models task now includes an output option to create a table in an item store format. You can use this table in the new Aggregate Loss Models task. For more information, see “SAS Viya: Severity Models” in SAS Studio: Task Reference Guide.

### SAS Viya Forecasting

In the Time Series Exploration task, creating output data tables is now optional. For more information, see “Time Series Exploration” in SAS Studio: Task Reference Guide.
Chapter 1
Introduction to SAS Studio

About SAS Studio

SAS Studio is a development application for SAS that you access through your web browser. With SAS Studio, you can access your data files, libraries, and existing programs, and you can write new programs. You can also use the predefined tasks in SAS Studio to generate SAS code. When you run a program or task, SAS Studio connects to a SAS server to process the SAS code. The SAS server can be a hosted server in a cloud environment or a remote server in your local environment. After the code is processed, the results are returned to SAS Studio in your browser.
SAS Studio supports multiple web browsers, such as Microsoft Internet Explorer, Microsoft Edge, Apple Safari, Mozilla Firefox, and Google Chrome. For more information, see *SAS Viya for Linux: Deployment Guide*.

In addition to writing and running your own SAS programs, you can use the predefined tasks that are included with SAS Studio to analyze your data. The tasks are based on SAS System procedures and provide access to some of the most commonly used graph and analytical procedures. You can also use the default task template to write your own tasks.

SAS Studio includes two different perspectives: the Standard perspective and the Interactive perspective. A perspective is a predetermined set of features that is customized to meet the needs of a specific user type. By selecting a specific perspective, you can narrow the choices that are available in the interface and focus on the features that you need to use regularly. By default, when you open SAS Studio, the Standard perspective is selected. After you open SAS Studio, you can change the perspective by using the Options menu on the toolbar. For more information, see “Understanding Perspectives” on page 13.

---

**Using SAS Studio**

**About Using SAS Studio**

When you sign on to SAS Studio, the main SAS Studio window appears with a blank program window so that you can start programming immediately. You also have access to all five sections of the navigation pane.

*Note:* To sign out of SAS Studio, click your user name on the application toolbar and select **Sign Out**. Do not use the Back button on your web browser.
The main window of SAS Studio consists of a navigation pane on the left and a work area on the right. The navigation pane provides easy access to your open files, your folder shortcuts and SAS content, your tasks and snippets, the libraries that you have access to, and your file references. The Open Files section is displayed by default. The File References section is not displayed by default, but can be opened by using the View menu. For more information, see “Using File References” on page 6.

The work area is used to display your data, code, tasks, logs, and results. As you open these items, they are added to the work area as windows in a tabbed interface.

**Using the Navigation Pane**

*About Using the Navigation Pane*

You can expand the sections of the navigation pane by clicking the section that you want to view. To close and reopen the navigation pane, click a section button twice.

*Note:* If you want to drag an item to another location in a section of the navigation pane that has a scrollbar, drag the item to the top right or lower right corner of the pane to scroll up or down.

*Accessing Your Open Files*

The Open Files section of the navigation pane enables you to quickly view and access all of the files that you have opened in your current SAS Studio session. To access a file from the list of open files, click the file that you want to view. You can also save changes to all files in the list by clicking *Save all*.

*Using the Explorer*

The *Explorer* section of the navigation pane enables you to access files and folders from your SAS Drive location. For more information, see *SAS Drive: Getting Started*. 
You can use the **Explorer** section to create folders and folder shortcuts as well as download and upload files. From the folders tree, you can expand and collapse folders, copy and move items, and open items in folders by double-clicking them or dragging them to the work area. In addition, you can open files from your folders and folder shortcuts by clicking the folder icon on the SAS Studio toolbar.

You can view items in a folder as text by right-clicking the file and selecting **View file as text**.

To open a file as a SAS program, right-click the file and select **Open as program**.

To create a new folder shortcut:

1. Click the folder icon in the navigation pane to open the Explorer pane. Then click the folder icon and select **Folder shortcut**. The New Folder Shortcut window appears.
2. In the **Name** box, enter the name of the folder shortcut.
3. Click the folder icon to select a directory. To create a new folder when you are selecting a directory, click the folder icon.
4. Click **OK** to create the folder shortcut. The new shortcut is added to the list of folder shortcuts.

*Note:* You can rename a folder shortcut by selecting the folder shortcut in the Explorer pane and clicking the folder icon. In the Shortcut Properties window, enter a new name in the **Name** box.

To create a new folder, select the folder in the **Explorer** section in which you want to create the new folder. Click the folder icon and select **Folder**. The New Folder window appears. Enter the name of the new folder. The new folder is added to the list of folders.

To download one or more files, right-click the files that you want to download and select **Download file**.

To upload one or more files from your local computer, select the folder to which you want to upload the files and click the folder icon. The Upload Files window appears. Click the plus icon to browse for the files that you want to upload. The maximum size of each uploaded file cannot exceed 100 MB.

*Note:* You can sort the files that are listed in the Explorer pane by right-clicking the folder that you want to sort and selecting **Sort by**. You can sort the files by name, modified date, or size or choose no sort order. By default, the files are sorted in ascending order by filename.

### Working with Tasks

The **Tasks** section of the navigation pane enables you to access tasks in SAS Studio. Tasks are based on SAS procedures and generate SAS code and formatted results for you. SAS Studio is shipped with several predefined tasks that you can run. You can also edit a copy of these predefined tasks, and you can create your own new tasks.

To create a new task, click the folder icon and select **Task**. SAS Studio creates a template in the work area that you can use to create custom tasks for your site. Custom tasks can be accessed from the My Tasks folder or from the **Explorer** section of the navigation pane. For more information, see Chapter 5, “Understanding Tasks in SAS Studio,” on page 55.

To edit a task that you have created, right-click the task in the My Tasks folder and select **Edit**. The XML code that is used to create the task is opened in the work area. If you want to edit a predefined task, you must first right-click the task and select **Add to My**
Tasks or Add to Explorer. For more information, see “Edit a Predefined Task” on page 56.

**Working with Snippets**

The Snippets section of the navigation pane enables you to access your code snippets. Code snippets are samples of commonly used SAS code that you can insert into your SAS program. SAS Studio is shipped with predefined code snippets that you can use. You can also edit a copy of these snippets and create your own custom snippets. Your custom snippets can be accessed from the My Snippets folder. For more information, see Chapter 2, “Working with Programs,” on page 17.

To edit a snippet that you have created, double-click the snippet to open it in the program editor and enter your changes. If you want to edit a predefined snippet, you must first right-click the snippet and select Add to My Snippets.

*Note:* You can edit only the snippets that are in the My Snippets folder.

**Working with Libraries**

The Libraries section of the navigation pane enables you to access your SAS libraries. SAS tables are stored in SAS libraries. From the Libraries section, you can open SAS tables and add them to your programs. You can use the Libraries section to expand a table and view the columns in that table. The icon in front of the column name indicates the type.

*Note:* If you are using SAS Viya 3.4 with an Apache Hadoop deployment, the CASUSERHDFS library name is truncated to CASUSERH. Other caslib names that are longer than eight characters are not accessible in SAS Studio.

Here are examples of common icons for the column types.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Type of Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>📃</td>
<td>Character</td>
</tr>
<tr>
<td>📃</td>
<td>Numeric</td>
</tr>
<tr>
<td>📃</td>
<td>Date</td>
</tr>
<tr>
<td>📃</td>
<td>Datetime</td>
</tr>
</tbody>
</table>

You can drag tables and columns from the Libraries section to a program, and SAS Studio adds the names of the dragged items to your program. If the item name is a reserved word in a database, SAS Studio creates a name literal by automatically adding quotation marks and a lowercase letter n to the item name. For more information, see “Opening and Creating Programs” on page 18.

*Note:* The Sasuser library is read only, as in any SAS server environment. You cannot save content to this library.

You can also create new libraries and assign existing libraries.

To create a new library:

1. Click 📃 in the navigation pane and then click 📃. The New Library window appears.
2. In the **Name** box, enter the libref for the library. The libref must be eight characters or fewer.

3. In the **Path** box, enter the physical path where the library resides. The path must be a location that you can access on the SAS server to which SAS Studio is connected.

4. In the **Options** box, specify any configuration options that you need. For the appropriate options, see the documentation for your operating environment.

5. If you want to access this library each time you use SAS Studio by adding it to your SAS autoexec file, select **Re-create this library at start-up**.

6. Click **OK** to create the library. The new library is added to the list of libraries in the navigation pane.

### Using File References

File references enable you to quickly access files that you specify. You can create a file reference to a file in your SAS Content folder, via a URL, or on your SAS server. You can use the SAS Studio user interface to create a file reference to a file in your SAS Content folder or via a URL. To create a file reference to a file on your SAS server, you must use the FILENAME statement.

**Note:** You can also use the FILENAME statement to create a file reference to a file in a remote location that is accessible by your SAS server.

To create a new file reference to a file in your SAS Content folder or via a URL:

1. Click the **File References** icon in the navigation pane and then click **+**. The New File Reference window opens.
2. In the Name box, enter the file reference name.

3. To define a reference to a file in your SAS Content folder, select FILESRVC as the Access method. In the Location box, browse to find the file that you want to use.

   To define a reference to a file by accessing a URL, select URL as the Access method. In the URL box, enter the URL address for the file.

4. If you want this reference to be available the next time you use SAS Studio, select Re-create this file reference at start-up.

5. Click OK to create the file reference. The new file reference is added to the list of file references in the navigation pane.

To create a file reference to a file on or accessible by your SAS server:

- In the program editor, enter and run a FILENAME statement using the following syntax:

  ```
  FILENAME fileref 'external-file';
  ```

  Note: Make sure that you specify the complete pathname for the external file and use the proper path syntax for the operating system that your SAS server is running. For example, Microsoft Windows uses backslashes (\) in its pathnames, and UNIX uses forward slashes (/).

You can open a file from a file reference by double-clicking it or dragging it to the work area.

**Customizing the Navigation Pane**

By default, five sections of the navigation pane are displayed when you open SAS Studio in the Standard perspective. To customize which sections are displayed, click View and select Navigation panes. Select or clear any sections that you want to add or remove. The navigation pane is updated immediately.

*Note:* The File References section is not displayed by default.

---

**Using the Work Area**

**About Using the Work Area**

The work area is the main portion of the SAS Studio application for accessing programs and tasks and for viewing data. The work area is always displayed and cannot be closed. When you open a program, task, or table, the windows open as new tabs in the work
area. The code, log, and results that are associated with programs and tasks are grouped together under the main tab for the program or task.

Customizing the Work Area

By default, the work area is displayed beside the navigation pane, but you can maximize the work area and hide the navigation pane. You can also close all of the tabs in the work area at once.

To maximize the work area, select View > Fullscreen.

Note: To reopen the navigation pane, double-click any tab in the work area or right-click a tab and select Restore.

You can also close some or all of the open tabs in the work area. To close all tabs that are open in the work area, right-click any tab and select Close all. To close all tabs except the active tab, right-click the active tab and select Close others. You are prompted to save any unsaved programs or tasks.

Rearranging the Tabs in the Work Area

In the work area, you can rearrange the tabs by dragging them to the left or right. You can also create separate vertical and horizontal groups and move tabs between the groups. To rearrange a tab, right-click the tab that you want to move and select the appropriate option.
Searching in SAS Studio

You can use the Search feature to search all of the sections of the navigation pane. You can specify which sections and which types of items you want to include in your search. You can also specify whether you want the search to be case-sensitive and match whole words only.

To access the Search feature, select View > Search. The Search tab opens in the workspace.
To search for an item, enter the text that you want to search for in the search term box.
To specify the areas of the navigation pane to search, click  
To make your search case-sensitive, click  
To match the whole word in your search, click  
When you have specified your search criteria, click . You can open items in the search results by double-clicking them.
Using the Console

The Console window displays a list of all of the messages, such as error messages and warnings, that are generated as you run programs and tasks. To open the console, select View > Console. In the lower right corner of the work area, you can also click to restore the console or to maximize the console.

You can use the buttons at the top of the window to filter the types of messages that are displayed. By default, all types of messages are displayed. The messages are cleared by default when you sign out of SAS Studio. You can manually clear the messages from the console by clicking Clear All.
Using the Submission Status Window

The Submission Status window displays information about the programs and tasks that you run in SAS Studio. To open the Submission Status window, select View > Submission Status or click Submission Status in the lower right corner of your SAS Studio browser window. You can subset the messages that are displayed by clicking the type of message that you want to view. You can also click Clear all to remove all entries from the list and Cancel all to cancel all programs and tasks that are currently running.
Understanding Perspectives

Because SAS Studio can be used by a variety of people and groups within an organization, you can choose to view a specific subset of features, or perspective, that meets your needs best. Perspectives are sets of functionality that are customized to meet the needs of different types of users. SAS Studio includes two perspectives: the Standard perspective and the Interactive perspective.

The Standard perspective is for users who want to be able to both write SAS programs and use the predefined tasks. In the Standard perspective, SAS program files are run as a whole. By default, the Standard perspective opens with a new program window and includes five sections of the navigation pane: Open Files, Explorer, Tasks, Snippets, and Libraries.

The Interactive perspective is designed for users who intend to use SAS Studio mainly for writing and editing SAS programs that use interactive SAS procedures. By default, the Interactive perspective opens with a new program window, and the Log and Results tabs are displayed in a separate horizontal tab group. In addition, the log data and results from all of your program tabs are appended together in one log tab and one results tab. In the Standard perspective, there are separate log and results tabs for each program. For more information, see “Working with the Interactive Perspective” on page 28.

The differences between the perspectives can be viewed in the following table:
<table>
<thead>
<tr>
<th>Element in SAS Studio</th>
<th>Available in Standard?</th>
<th>Available in Interactive?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation Pane sections</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Open Files</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>• Explorer</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>• Tasks</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>• Snippets</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>• Libraries</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>• File References</td>
<td>Yes, but not displayed by default</td>
<td>Yes, but not displayed by default</td>
</tr>
<tr>
<td>Options to recall code and clear code on submit</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Options to generate PDF, RTF, Excel, and PowerPoint output</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability to export data</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability to print data</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability to validate an expression in the Filter Table Rows window</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability to validate the autoexec.sas file</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

After you have started SAS Studio, you can change the perspective that you are using by selecting **Options > Change perspective** and selecting the perspective that you want to use.

You can specify which sections of the navigation pane are displayed in SAS Studio by selecting **View > Navigation panes**.

### Editing the Autoexec File

The autoexec.sas file includes SAS statements that run each time you start SAS Studio and connect to your SAS server. For example, you can use the autoexec.sas file to assign libraries that you want to be available every time you use SAS Studio in both the Standard and Interactive perspectives.

*Note:* If you create a new library by using the New Library window, you can select the **Re-create this library at start-up** option to automatically add the LIBNAME statement to the autoexec.sas file. For more information, see “Working with Libraries” on page 5.
To edit the autoexec.sas file:

1. Select Options > Autoexec file.
2. Enter the code that you want to include in the autoexec.sas file.
3. To validate your syntax, click Run. The Log tab opens so that you can view the log.
   
   Note: The option to run the autoexec file is available only in the Standard perspective. For more information, see “Understanding Perspectives” on page 13.
4. Click Save to save and close the autoexec file.

### Resetting Your SAS Session

You can terminate your current SAS session and create a new workspace session by using the Reset SAS Session option. The Reset SAS Session option terminates your current workspace session by running the ENDSAS statement and then creates a new workspace session. When the new workspace session is started, SAS Studio runs the autoexec file to initialize the session. To reset your SAS session, select Options > Reset SAS Session.
Chapter 2

Working with Programs

About the Code Editor

SAS Studio includes a color-coded, syntax-checking editor for editing new or existing SAS programs. You can also edit SOURCE entries in SAS catalogs. The editor includes a wide variety of features such as autocompletion, automatic formatting, and pop-up syntax help. With the code editor, you can write, run, and save SAS programs. You can also modify and save the code that is automatically generated when you run a task.

SAS Studio also includes several sample code snippets that you can use to make programming common tasks easier.
Opening and Creating Programs

Opening a Program

You can open SAS programs from the Explorer section of the navigation pane. To open a program, expand the appropriate folder and double-click the program that you want to open, or right-click the program in the navigation pane and select Open. The program opens in a new tab in the work area.

Note: You can also open a file by clicking Open on the toolbar and selecting a file from your available folders. If you are opening a program or text file, then you can specify the text encoding that you want to use by selecting Open with encoding and clicking Open. Use the Select Encoding window to specify the encoding that you want.

In the lower right corner of the program editor, you can view the current line and column position of the cursor. If you are viewing a *.sas or *.txt file, the text encoding is displayed as well. To go to a specific line in the program, click the line position and enter the line number in the Go to line box. You can also click the text encoding and select another character-set encoding option.
Creating a New Program

To create a new program, select New > Program. A program window opens in a new tab in the work area.

Note: You can also create new text and XML files by selecting New > Text or New > XML.

Running a Program

After you have written your program, you can run the entire program or you can select specific lines of code to run. To run the entire program, click Submit on the toolbar. To run a portion of the program, select the lines of code that you want to run and then click Submit.

By default, if there are no errors, the results open automatically, and if there are errors, the Log tab opens. You can click one or more of the Errors, Warnings, and Notes sections to view the messages. When you click a message, SAS Studio highlights it for you in the log so that you can see exactly where the message occurs in the log.

Note: You can specify which tab you want to display after you run a program or task by using the General preferences. For more information, see “Setting General Preferences” on page 62.

Note: Because you are working in a server environment, do not include the ENDSAS statement in your SAS programs. If you run a program that contains ENDSAS, reset your SAS session by selecting Options > Reset SAS Session.
Saving a Program

To save updates to an existing program in its current location, click on the toolbar. To save the entire program with a new name or location, click . If you want to specify the text encoding when you save a program or text file, use the text encoding button in the lower right corner of the program editor to select a new encoding option before you save the file.

Note: You can also create a SAS program package or a program summary when you save your program. For more information, see “Creating a SAS Program Package” on page 25 and “Creating a Program Summary” on page 26.

Using the Autocomplete Feature

About the Autocomplete Feature

The autocomplete, or code completion, feature in the code editor can predict the next word that you want to enter before you actually enter it completely. The autocomplete feature can complete keywords that are associated with SAS procedures, statements, macros, functions, CALL routines, formats, informats, macro variables, SAS colors, style elements, style attributes, and statistics keywords, and various SAS statement and procedure options. The autocomplete feature can also complete librefs and table names.

Note: The autocomplete feature is available only for editing SAS programs.

This example shows the keywords and help that appear when you enter proc a in the code editor.
In this example, you select **APPEND** from the list of procedures, so that `proc append` appears in the code editor. When you enter a space, the code editor displays a list of options for the APPEND procedure.

**How to Use the Autocomplete Feature**

To use the autocomplete feature:

1. How you open the autocomplete list depends on the keyword that you want to add.
   - If you want to add a global statement, DATA step statement, CALL routine, procedure, macro statement, or automatic macro variable, enter the first one or more letters of the keyword that you want to use.

   A window opens with a list of suggested keywords that begin with those letters.

   - If you want to specify colors, formats, informats, macro functions, SAS functions, statistics keywords, style elements, or style attributes, position your mouse pointer in a comment and press Ctrl+spacebar. To navigate through the list of options backward, press Ctrl+Shift+spacebar or use the arrow keys at the top of the pop-up window.
Note: These shortcuts work even if you have deselected the Enable autocomplete option in the Preferences window. For more information, see “Customizing the Code Editor” on page 39.

2. You can navigate to the keyword that you want to use in several ways:
   - Continue to type until the correct keyword is selected (because the matching improves as you type).
   - Scroll through the list by using the up and down arrow keys, the Page Up and Page Down keys, or your mouse.

3. You can add the keyword to your program by double-clicking the selected keyword or by pressing the Enter key.

Using the Syntax Help

The code editor displays brief SAS syntax documentation as you write and edit your programs. You can display the Help in the following ways:
   - Right-click a keyword in your program and select Syntax Help.
   - Start entering a valid SAS keyword, and then click a suggested keyword in the autocomplete window.
   - Position the mouse pointer over a valid SAS keyword in your program. This works only if you have selected the Enable hint when you hover over keywords option in the Editors preferences. For more information, see “Customizing the Code Editor” on page 39.

The SAS Product Documentation provides more comprehensive usage information about the SAS language, but the syntax help in the code editor can get you started with a hint about the syntax or a brief description of the keyword. You can get additional help by clicking links in the syntax help window as follows:
   - Click the keyword link at the top of the window to search the support.sas.com website for the keyword.
• Click the links at the bottom of the window to search for the keyword in the SAS Product Documentation, Samples and SAS Notes, and SAS Technical Papers.
Matching Parentheses

You can use the parenthesis matching feature to track nested parentheses within a program. The code editor highlights both the open and close parentheses. If only one parenthesis is highlighted, then you know that you are missing a parenthesis. This feature can be used to match parentheses, square brackets, and braces.

```
do y = -5 to 5 by .5;
   z = sin(sqrt(y^2 + x^2));
```

To match parentheses, position the cursor in front of the open parenthesis or just after the close parenthesis that you want to match. The parenthesis and its match are highlighted. If the parenthesis does not have a match, then it is not highlighted.

*Note:* You can use the Code Editor Settings page to turn the Highlight matching brackets option off. You can also select an option to automatically insert a closing bracket or parenthesis. For more information, see “Setting General Code Editor Preferences” on page 67.

Selecting Columns of Text

You do not have to select entire horizontal lines of text. You can select columns or vertical blocks of text.

To select a column or vertical block of text:

- In Window environments, press the ALT key while you select the text with the left mouse button.
- In Mac OS X environments, press the Option key while you select the text with the left mouse button.

Adding Table Names and Column Names

From the Libraries section of the navigation pane, you can use a drag-and-drop operation to move table names and column names into the SAS code. For example, you can move the Sashelp.Cars table into the DATA option for the PRINT procedure. When you release the mouse, the fully qualified name for the table appears in your code.

*Note:* If the table or column name is a reserved word in a database, SAS Studio creates a name literal by automatically adding quotation marks and a lowercase letter n to ensure that the name is evaluated correctly by your program.

Inserting a Pathname

From the Explorer section of the navigation pane, you can right-click a folder or a *.sas file and select Insert as path to add the pathname of the folder or the pathname and filename of the file to your program. For example, you can right-click a folder such as /products/salesdata/ and select Insert as path to add it to a LIBNAME statement.
Editing the Code from a Task

You can edit the code that is generated automatically when you run a task and then run it with your modifications. When you edit the code, SAS Studio opens it in a separate program window. The code is no longer associated with the original task.

To edit a program generated by a task:

1. On the appropriate task tab in the work area, click **Code** to display the code that is associated with the task.

2. On the toolbar, click **Edit**. The code is opened in a new program window.

Creating a SAS Program Package

A SAS Program Package is a file that contains a snapshot of a SAS program along with its log and HTML results. You can create a program package from code that you have written as well as code that is automatically generated when you run a task. When you open a program package in SAS Studio, you can access the code, log, and results without running the program again. If you make changes to the code and rerun it, the package is not automatically updated. You must save the package again to keep the changes.

*Note:*

- The program package does not include PDF or RTF results.
• You cannot create a program package if you are using the Interactive perspective.

To create a program package file, open the code that you want to use and click 🛠. Specify the file location and name, and then select Package as the Type option.

Note: If you open a program package file and want to save the program or log individually or download the results as an HTML, PDF, or RTF file, you must resubmit the program after you open the program package file.

Creating a Program Summary

You can create a summary page for code that you have written as well as code that is automatically generated when you run a task. The Program Summary page is an HTML file that opens in a separate browser tab and includes information about the program execution, the complete SAS source code, the complete SAS log, and the results. To view the Program Summary page for a program, click 🌏 and select Open in a browser tab > Summary.

Note: The Program Summary is available only after you have run the program.

You can also save a Program Summary file to a folder that you specify by clicking 🛠 and selecting Summary as the Save as type option. The Program Summary is saved as an HTML file.

Using Macro Variables

Macro variables can be used to add information that is obtained when a program or task is run, such as the name and version number of the application. You can reference these items within code, titles, or footnotes by preceding them with "&_".

For example, you can use macros in a footnote like the following:

Generated with &_CLIENTAPP &_CLIENTAPPVERSION

Note: In addition to the following macro variables, you can run this code to see other user-generated and automatic macro variables that are available:

%PUT &ALL_;

For information about SAS macro functions and variables, see SAS Macro Language Reference.

<table>
<thead>
<tr>
<th>Macro Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_CLIENTAPP</td>
<td>Name of the client application.</td>
</tr>
<tr>
<td>_CLIENTAPPABREV</td>
<td>Abbreviated name of the client application.</td>
</tr>
<tr>
<td>_CLIENTMACHINE</td>
<td>Node name of the client machine.</td>
</tr>
<tr>
<td>_CLIENTMODE</td>
<td>Type of SAS Studio deployment: Mid-Tier (enterprise), Single User, or Basic.</td>
</tr>
<tr>
<td>_CLIENTVERSION</td>
<td>Application version, including build number.</td>
</tr>
<tr>
<td>_SASHOSTNAME</td>
<td>Server node name (IP address or DNS name).</td>
</tr>
<tr>
<td>Macro Variable</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>_SASPROGRAMFILE</td>
<td>The full path and filename of the SAS program that is currently being run. This macro variable is available only for SAS program files that are saved on the same server on which your SAS Studio code is running.</td>
</tr>
<tr>
<td>_SASPROGRAMFILEHOST</td>
<td>The server node name on which the current SAS program is being run.</td>
</tr>
<tr>
<td>_SASWORKINGDIR</td>
<td>Current working directory.</td>
</tr>
<tr>
<td>SASWORKLOCATION</td>
<td>Location of the Work library.</td>
</tr>
<tr>
<td>SYSPROCESSNAME</td>
<td>Name of the current SAS process.</td>
</tr>
<tr>
<td>SYSPROCESSMODE</td>
<td>Current SAS session run mode or server type name.</td>
</tr>
<tr>
<td>SYSVLONG4</td>
<td>SAS software release number, maintenance level, and four-digit year.</td>
</tr>
</tbody>
</table>

Note: If you specify %put _all_ or %put _global_ in your SAS program, the output does not include any special characters. For example, slashes are not included in directory paths. To view the output with these special characters, you must specify the individual macro variable by name, such as %put &_sasprogramfile;.

Using Your Submission History

SAS Studio maintains a log with entries for each time you run a program or task. You can use this log, or submission history, to access prior versions of your submitted code. To view your submission history, click History on the toolbar and select the version that you want to open. The prior version of the program opens in a new window from which you can copy and paste the code as needed. You can also clear your submission history by selecting History > Clear history.

Note: The submission history is cleared automatically when you sign off from SAS Studio.

Note: You can also use the Submission Status window to view information about the programs and tasks that you have run. For more information, see “Using the Submission Status Window” on page 12.

Automatically Formatting Your SAS Code

You can use the code editor to make your programs easier to read by automatically formatting your code. When you automatically format your code, line breaks are added, and each line is correctly indented according to its nesting level. To format the code in the code editor, right-click in the code editor and select Format code. You can also choose to format a selected section of your code.
For example, the following code is difficult to read because it lacks indentation and logical line breaks:

```sas
data topn;
length rank 8; label rank="Rank";
set topn; by &category descending &measure;
if first.&category then rank=0; rank+1;
if rank le &n then output;
run;
```

After you use the automatic code-formatting feature, the program looks like this:

```sas
data topn;
  length rank 8;
  label rank="Rank";
  set topn;
  by &category descending &measure;
  
  if first.&category then
    rank=0;
    rank+1;
  
  if rank le &n then
    output;
run;
```

---

### Working with the Interactive Perspective

#### What Is the Interactive Perspective?

Some SAS procedures are interactive, which means they remain active until you submit a QUIT statement, or until you submit a new PROC or DATA step. In SAS Studio, you can use the code editor to run these procedures, as well as other SAS procedures, in the Interactive perspective.

By using the Interactive perspective, you can run selected lines of code from your SAS program and use the results to determine your next steps. For example, the OPTMODEL procedure in SAS/OR enables you to model and solve mathematical programming models. By running this procedure interactively, you can quickly check results for parts of the program and determine whether you need to make any modifications without running the entire program.

#### Running a Program in the Interactive Perspective

When you run a program in the Interactive perspective, SAS Studio does not add any automatically generated code, such as ODS and %LET statements, to your program. In addition, results are generated only in HTML. In the Interactive perspective, the log and results are appended to the existing log and results. Previously submitted code remains active until you terminate it.

For example, suppose you have the following program:

```sas
proc sql;
  select * from sashelp.cars;

  select * from sashelp.class;
quit;
```
In the Standard perspective, if you select the first two lines of code and submit them, the code runs successfully. If you then select the last two lines of code and submit them, the code fails because the PROC SQL statement is missing.

If you switch to the Interactive perspective and follow the same steps, the last two lines of code run successfully because the PROC SQL statement is still active.

Note: For documentation about specific procedures, see the SAS Programmer’s Bookshelf on support.sas.com.

Working with Code Snippets

Why Use Code Snippets?

Code snippets enable you to quickly insert SAS code into your program and customize it to meet your needs. SAS Studio is shipped with several code snippets.

<table>
<thead>
<tr>
<th>Snippet Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalogs</td>
<td>Enables you to specify the content for the SOURCE entry type in a catalog. The SOURCE entry can contain the same code as SAS programs.</td>
</tr>
<tr>
<td>Edit a SOURCE Entry</td>
<td>Lists the contents of a specified type in a specified catalog. By default, the snippet shows how to list all types as well as only the CLASS type in the catalog Sashelp.FSP.</td>
</tr>
<tr>
<td>List Catalog Entries</td>
<td>Creates and displays a SAS table listing all of the categories in a specified library. By default, the table is saved as Work.catalogs.</td>
</tr>
<tr>
<td>List Catalogs</td>
<td>Provides a template for a DS2 program. DS2 is a SAS programming language that is appropriate for advanced data manipulation. DS2 is included with Base SAS and shares core features with the SAS DATA step. DS2 exceeds the DATA step by adding variable scoping, user-defined methods, ANSI SQL data types, and user-defined packages. The DS2 SET statement accepts embedded FedSQL syntax, and the run-time-generated queries can exchange data interactively between DS2 and any supported database. This allows SQL preprocessing of input tables, which effectively combines the power of the two languages. For more information, see SAS DS2 Language Reference.</td>
</tr>
<tr>
<td>Snippet Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DS2 Package</td>
<td>Provides a template for a DS2 package. A package is similar to a DS2 program. The package body consists of a set of global declarations and a list of methods. The main syntactical differences are the PACKAGE and ENDPACKAGE statements. These statements define a block with global scope. For more information, see <em>SAS DS2 Language Reference</em>.</td>
</tr>
<tr>
<td>DS2 Thread</td>
<td>Provides a template for a DS2 threaded program. Typically, DS2 code runs sequentially. That is, one process runs to completion before the next process begins. It is possible to run more than one process concurrently, using threaded processing. In threaded processing, each concurrently executing section of code is said to be running in a thread. For more information, see <em>SAS DS2 Language Reference</em>.</td>
</tr>
<tr>
<td>Generate CSV File</td>
<td>Exports SAS data as a comma-separated text file.</td>
</tr>
<tr>
<td>Generate PowerPoint Slide</td>
<td>Streams Microsoft PowerPoint output to your web browser.</td>
</tr>
<tr>
<td>Generate XML File</td>
<td>Exports SAS data as an XML file that you can view in your web browser.</td>
</tr>
<tr>
<td>Import CSV File</td>
<td>Imports a comma-separated file and writes the output to a SAS data set.</td>
</tr>
<tr>
<td>Import XLSX File</td>
<td>Imports a Microsoft XLSX file and writes the output to a SAS data set.</td>
</tr>
<tr>
<td>Simulate Linear Regression Data</td>
<td>Creates an input data source that you can use for linear regression analysis. Linear regression analysis tries to assign a linear function to your data by using the least squares method.</td>
</tr>
<tr>
<td>Simulate One-Way ANOVA Data</td>
<td>Creates an input data source that considers one treatment factor with three treatment levels. When you analyze this data by using the One-Way ANOVA task, the goal is to test for differences among the means of the levels and to quantify these differences.</td>
</tr>
<tr>
<td>Descriptive</td>
<td></td>
</tr>
<tr>
<td>Custom ODS Output</td>
<td>Provides a template for creating HTML, PDF, and RTF output by using the SAS Output Delivery System. For more information, see <em>SAS Output Delivery System: User’s Guide</em>.</td>
</tr>
<tr>
<td>PROC SQL</td>
<td>Provides a template for writing SQL queries. For more information, see <em>SAS SQL Procedure User’s Guide</em>.</td>
</tr>
</tbody>
</table>

**Note:** For more information about the SGPLOT, SGPANEL, and SGSCATTER procedures, see *SAS ODS Graphics: Procedures Guide*. 
<table>
<thead>
<tr>
<th>Snippet Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Panel</td>
<td>Uses the VBAR statement in the SGPANEL procedure and enables you to create multiple bar charts.</td>
</tr>
<tr>
<td>Box Panel</td>
<td>Uses the VBOX statement in the SGPANEL procedure and enables you to create multiple box plots.</td>
</tr>
<tr>
<td>Comparative Scatter Plot</td>
<td>Uses the COMPARE statement in the SGSCATTER procedure. This code snippet creates a comparative panel of scatter plots with shared axes.</td>
</tr>
<tr>
<td>Dot Plot</td>
<td>Uses the DOT statement in the SGPLOT procedure. Dot plots summarize horizontally the values of a category variable. By default, each dot represents the frequency for each value of the category variable.</td>
</tr>
<tr>
<td>Fit Plot</td>
<td>Uses the REG statement in the SGPLOT procedure. This code snippet produces a regression plot with a quadratic fit and includes confidence limits.</td>
</tr>
<tr>
<td>HBar Plot</td>
<td>Uses the HBAR statement in the SGPLOT procedure. This code snippet creates a horizontal bar chart that summarizes the values of a category variable.</td>
</tr>
<tr>
<td>HighLow Plot</td>
<td>Uses the HHIGHLOW statement in the SGPLOT procedure. High-low charts show how several values of one variable relate to one value of another variable. Typically, each variable value on the horizontal axis has several corresponding values on the vertical axis.</td>
</tr>
<tr>
<td>Histogram Plot</td>
<td>Uses the HISTOGRAM statement in the SGPLOT procedure. This code snippet produces a histogram with two density plots. In this snippet, one density plot uses a normal density estimate and the other density plot uses a kernel density estimate.</td>
</tr>
<tr>
<td>Scatter Plot Matrix</td>
<td>Uses the MATRIX statement in the SGSCATTER procedure. This code snippet creates a scatter plot matrix.</td>
</tr>
<tr>
<td>VBox Plot</td>
<td>Uses the VBOX statement in the SGPLOT procedure. A box plot summarizes the data and indicates the median, upper and lower quartiles, and minimum and maximum values. The plot provides a quick visual summary that easily shows center, spread, range, and any outliers. The SGPLOT and the SGPANEL procedures have separate statements for creating horizontal and vertical box plots.</td>
</tr>
</tbody>
</table>

**IML**

*Note: These snippets are available only if your site licenses SAS/IML.*

Find Roots of Nonlinear Equation | Enables you to find the roots of a function of one variable. Finding the root (or zero) of a function enables you to solve nonlinear equations.
<table>
<thead>
<tr>
<th>Snippet Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit by using Maximum Likelihood</td>
<td>Uses maximum likelihood estimation to estimate parameters for the normal density estimate.</td>
</tr>
<tr>
<td>Generate a Bootstrap Distribution</td>
<td>Uses the IML procedure to create and analyze a bootstrap distribution of the sample mean.</td>
</tr>
<tr>
<td>Integrate a Function</td>
<td>Enables you to numerically integrate a one-dimensional function by using the QUAD subroutine in SAS/IML software. Use the QUAD subroutine to numerically find the definite integral of a function on a finite, semi-infinite, or infinite domain.</td>
</tr>
<tr>
<td>Simulate Multivariate Normal Data</td>
<td>Simulates data from a multivariate normal distribution with a specified mean and covariance.</td>
</tr>
<tr>
<td>Macro</td>
<td>Provides a basic template for working with SAS macros. Macros enable you to perform many tasks, including substituting text in a program. A SAS program can contain any number of macros, and you can invoke a macro multiple times in a single program. For more information, see SAS Macro Language: Reference.</td>
</tr>
<tr>
<td>SAS Macro Char Functions</td>
<td>Provides several examples of these SAS macros that work with character values:</td>
</tr>
<tr>
<td>- %EVAL function evaluates arithmetic and logical expressions by using integer arithmetic. This function operates by converting its argument from a character value to a numeric or logical expression. After the expression is evaluated, the result is converted back to a character value.</td>
<td></td>
</tr>
<tr>
<td>- %INDEX function returns the position of the first character of a string.</td>
<td></td>
</tr>
<tr>
<td>- %LENGTH function returns the length of a string.</td>
<td></td>
</tr>
<tr>
<td>- %SCAN function searches for a word that is specified by its position in a string.</td>
<td></td>
</tr>
<tr>
<td>- %SUBSTR function produces a substring of a character string.</td>
<td></td>
</tr>
<tr>
<td>- %UPCASE function converts values to uppercase.</td>
<td></td>
</tr>
<tr>
<td>Snippet Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| SAS Macro Do Statement    | Designates the beginning of a section of a macro definition that is treated as a unit until a matching %END statement is encountered. This macro section is called a %DO group. A simple %DO statement often appears in conjunction with %IF-%THEN-%ELSE statements to designate a section of the macro to be processed depending on whether the %IF condition is true or false.  
  
  *Note:* SAS also provides a %DO iterative statement, which is different from the code that is generated by this snippet. For more information, see *SAS Macro Language: Reference*. |
| SAS Macro If Statement    | Conditionally processes a portion of a macro. The expression that is the condition for the %IF-%THEN-%ELSE statement can contain only operands that are constant text or text expressions that generate text. |
| SAS Macro Parameters      | Names one or more local macro variables whose values you specify when you invoke the macro. There are two types of macro variables: positional and keyword. Parameters are local to the macro that defines them. You must supply each parameter name. You cannot use a text expression to generate it. A parameter list can contain any number of macro parameters separated by commas. The macro variables in the parameter list are usually referenced in the macro. |
SAS Macro Quoting

Provides examples of macro functions that tell the macro processor to interpret special characters and mnemonics as text rather than as part of the macro language.

- The `%STR` function masks special characters and mnemonic operators in constant text at macro compilation. This function masks these special characters and mnemonic operators: + - * / < > = ¬ ^ ~ ; , # blank AND OR NOT EQ NE LE LT GE GT IN

  This function also masks these characters when they occur in pairs and when they are not matched and are marked by a preceding %:' " ()

- The `%NRSTR` function masks special characters and mnemonic operators in constant text at macro compilation. This function masks all of the special characters and mnemonic operators listed for the `%STR` function. In addition, the `%NRSTR` function masks these characters: & %

- The `%BQUOTE` function masks special characters and mnemonic operators in a resolved value at macro execution. This function masks these special characters and mnemonic operators: ' " () + - * / < > = ¬ ^ ~ ; , # blank AND OR NOT EQ NE LE LT GE GT IN

- The `%SUPERQ` function masks all special characters and mnemonic operators at macro execution but prevents further resolution of the value. This function masks these special characters and mnemonic operators: & % ' " () + - * / < > = ¬ ^ ~ ; , # blank AND OR NOT EQ NE LE LT GE GT IN

- The `%QSCAN` function searches for a word and masks special characters and mnemonic operators.

- The `%QSUBSTR` function produces a substring and masks special characters and mnemonic operators.

- The `%QUPCASE` function converts a value to uppercase and returns a result that masks special characters and mnemonic operators.

- The `%UNQUOTE` function unmasks a value during macro execution so that any special characters and mnemonic operators are interpreted as macro language elements instead of text.

For more information about macro complication and macro execution, see *SAS Macro Language: Reference*. 
### SAS Macro Variables

Provides examples of how to create user-defined global and local macro variables. Macro variables are tools that enable you to dynamically modify the text in a SAS program through symbolic substitution. You can assign large or small amounts of text to macro variables. Then you can use that text by simply referencing the variable that contains the text.

Macro variables that are defined by the macro programmer are called user-defined macro variables. Macro variables that are defined by the macro processor are called automatic macro variables. You can define and use macro variables anywhere in SAS programs, except within data lines.

### SAS Viya Cloud Analytic Services

<table>
<thead>
<tr>
<th>Snippet Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create CAS Connection</td>
<td>Creates a connection to a CAS server. You must specify values for the CASHOST= and CASPORT= system options. The CAS statement connects the default session to the specified CAS server and CAS port.</td>
</tr>
<tr>
<td>New CAS Session</td>
<td>Starts a new CAS session named mySession using the existing CAS server connection.</td>
</tr>
<tr>
<td></td>
<td>When starting a new session, you can specify the CAS library to use, the time-out (in seconds) for the session, and the locale of the session.</td>
</tr>
<tr>
<td>Disconnect CAS Session</td>
<td>Disconnects from the CAS session named mySession. Before you disconnect, you can specify a value for the time-out (in seconds). You can reconnect to the session before the time-out expires. Otherwise, the session is terminated.</td>
</tr>
<tr>
<td>Reconnect CAS Session</td>
<td>Reconnects to a CAS session named mySession.</td>
</tr>
<tr>
<td>Terminate CAS Session</td>
<td>Terminates the CAS session named mySession. No reconnection is possible.</td>
</tr>
<tr>
<td>List CAS Session Options</td>
<td>Lists session options for the specified CAS session.</td>
</tr>
<tr>
<td>List CAS Sessions for SAS Client</td>
<td>Lists all the CAS sessions and session properties that are created by the SAS client or reconnected to by the SAS client.</td>
</tr>
<tr>
<td>List CAS Sessions for User ID</td>
<td>Lists all the CAS sessions that are known to the CAS server for the user ID that is associated with yourSessionName.</td>
</tr>
<tr>
<td>New caslib for Path</td>
<td>Creates a CAS library (myCaslib) for the specified path (/filePath/) and session (mySession). If you omit the SESSREF= option, the caslib is created and activated for the current session. The SUBDIRS option extends the scope of myCaslib to include subdirectories of (/filePath/). The LIBNAME statement creates a SAS libref for the CAS library.</td>
</tr>
<tr>
<td>Snippet Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Generate SAS librefs for caslibs</td>
<td>Creates a default CAS session and generates SAS librefs for existing CAS libraries so that the librefs are visible in the Libraries pane.</td>
</tr>
<tr>
<td>Save Table to caslib</td>
<td>Creates a permanent copy of an in-memory table <em>(sourceTableName)</em> from a CAS library <em>(sourceCaslib)</em>. The in-memory table is saved as <em>targetTableName</em> in the target caslib <em>targetCaslib</em>.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> You can determine the caslib that is associated with a CAS engine libref by right-clicking the libref in the Libraries pane and selecting Properties. The Server Session CASLIB field displays the caslib.</td>
</tr>
<tr>
<td>Load Data to caslib</td>
<td>Loads a table to the specified CAS library. The snippet includes the PROMOTE option so that the loaded data is available to all your active sessions.</td>
</tr>
<tr>
<td>Delete Table or File from caslib</td>
<td>Deletes a table or file from the CAS library. You can also remove an in-memory table.</td>
</tr>
<tr>
<td>Delete caslib</td>
<td>Deletes the specified CAS library.</td>
</tr>
<tr>
<td>SAS Viya Machine Learning</td>
<td>You must license and install SAS Visual Statistics to use these snippets.</td>
</tr>
<tr>
<td></td>
<td>For more information see <em>SAS Visual Statistics: Procedures</em>.</td>
</tr>
<tr>
<td>Load Data</td>
<td>Demonstrates how to load local data into CAS.</td>
</tr>
<tr>
<td>Prepare and Explore Data</td>
<td>Modifying, and preparing data prior to modeling. This snippet uses the Hmeq data set from the Machine Learning sample data library. The Hmeq data set is used as input and creates the Hmeq_prepped data set. The Hmeq_prepped data set is used in subsequent examples.</td>
</tr>
<tr>
<td>Compare Two ML Algorithms</td>
<td>Demonstrates fitting and comparing two Machine Learning algorithms for predicting the binary target in the Hmeq data set, which is included in the Machine Learning sample data library. You must run the Load Data and Prepare and Explore Data snippets before you run this snippet.</td>
</tr>
<tr>
<td>Compare Several ML Algorithms</td>
<td>Demonstrates fitting and comparing several Machine Learning algorithms for predicting the binary target in the Hmeq data set, which is included in the Machine Learning sample data library. You must run the Load Data and Prepare and Explore Data snippets before you run this snippet.</td>
</tr>
<tr>
<td>Generalized Linear Models</td>
<td>Demonstrates fitting and assessing generalized linear models using the GENSELECT procedure. You must run the Load Data and Prepare and Explore Data snippets before you run this snippet.</td>
</tr>
<tr>
<td>Snippet Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unsupervised Learning</td>
<td>Shows the entire workflow process, including data preparation, analysis, and visualization of the results. This snippet uses the Sashelp.Iris data set.</td>
</tr>
<tr>
<td>Supervised Learning</td>
<td>Shows the entire workflow process, including data exploration and preparation, modeling, and evaluation. This snippet uses the Sampleml.Hmeq data set, which is included in the Machine Learning sample data library.</td>
</tr>
<tr>
<td>SAS Viya Image Processing</td>
<td>You must license and install SAS Visual Data Mining and Machine Learning to use these snippets. For more information, see <em>SAS Visual Statistics: Procedures</em>.</td>
</tr>
<tr>
<td>Load Images</td>
<td>Loads the image action set from the specified path and creates a CAS table. The path parameter points to the directory that contains the images that you want to load. The path parameter is a subdirectory in the caslib directory where the images are stored. A typical workflow includes loading images and then processing them by using one of the other snippets to resize, rescale, or mutate them. The output from one snippet can be used as input for another snippet. Images can be saved to your computer for further processing by using the Save Images snippet.</td>
</tr>
<tr>
<td>Resize Images</td>
<td>Resizes one or more images based on the HEIGHT and WIDTH parameters that you specify. The HEIGHT parameter corresponds to the number of rows, and the WIDTH parameter corresponds to the number of columns. The input is a CAS table that contains the images that you want to resize, and the output is a CAS table that contains the resized images.</td>
</tr>
<tr>
<td>Rescale Images</td>
<td>Changes the depth of one or more images based on the options that you specify. You can specify any of these values for the TYPE parameter: “TO_8U”, “TO_32F”, or “TO_64F”. You can also use the ALPHA and BETA parameters to scale the values. The input is a CAS table that contains the images that you want to rescale, and the output is a CAS table that contains the rescaled images.</td>
</tr>
<tr>
<td>Mutate Images</td>
<td>Mutates one or more images using different augmentation techniques. You can specify any of these values for the TYPE parameter: ‘COLOR_JITTERING’, ‘COLOR_SHIFTING’, ‘DARKEN’, ‘HORIZONTAL_FLIP’, ‘INVERT_PIXELS’, ‘LIGHTEN’, ‘ROTATE_LEFT’, ‘ROTATE_RIGHT’, ‘SHARPEN’, or ‘VERTICAL_FLIP’. The input is a CAS table that contains the images that you want to change, and the output is a CAS table that contains the mutated images.</td>
</tr>
<tr>
<td>Snippet Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Convert Color</td>
<td>Converts the color space of one or more images. You can specify any of these values for the TYPE parameter: ‘BGR2HSV’, ‘BGR2RGB’, ‘BGR2YUV’, ‘COLOR2GRAY’, ‘GRAY2COLOR’, ‘HSV2BGR’, ‘RGB2BGR’, or ‘YUV2BGR’. The input is a CAS table that contains the images that you want to convert, and the output is a CAS table that contains the converted images.</td>
</tr>
<tr>
<td>Save Images</td>
<td>Saves the specified images to the specified subdirectory of a previously defined caslib, such as CASUSER. You must specify the name of a subdirectory in the caslib root directory. The names of the saved images start with the value of the PREFIX parameter.</td>
</tr>
<tr>
<td>Display Images</td>
<td>Displays an image that is saved from SAS Studio to your computer. This snippet creates an annotation data set that contains a reference to the image and uses PROC SGPLOT to display the image. Use the IMAGE= variable to specify the fully qualified name and location of the image that you want to display.</td>
</tr>
</tbody>
</table>

**Create a Code Snippet**

To create your own snippet:

1. Open your .sas file in SAS Studio and select the code that you want to save as a snippet. If you don’t select any code, the entire program is saved as a snippet.

2. On the **Code** tab, click **Add as Snippet**. The Add to My Snippets window appears.

   *Note:* You can also create a snippet by right-clicking the selected code and selecting **Add as Snippet**.

3. Enter a name for the snippet.

4. If you want to be able to quickly access the snippet by entering @snippet-abbreviation in the program editor, enter an abbreviation for the snippet. You can also add a description.

5. Select the folder in which you want to save the snippet and click **Save**.

This snippet is now available from the folder that you specified.

**How to Insert a Code Snippet**

To include a code snippet in your program:

1. Click the location in your program where you want to insert the snippet.

2. In the navigation pane, open the **Snippets** section.

3. You can add the snippet to your program in these ways:

   - use a drag-and-drop operation to insert the snippet into your program.
   - right-click the name of the snippet and select **Insert**.
• enter @snippet-name in your code and press Enter or Tab. You can also enter @ and use the pop-up window to select from a list of snippets in your My Snippets folder.

*Note:* In order to use this functionality, you must specify an abbreviation for the shortcut. To verify whether your snippet has an abbreviation, select the shortcut and click ![ abbreviation icon ]. You can add or edit the abbreviation in the Snippet Properties window. For more information, see “Create a Code Snippet” on page 38. You must also select the **Enable snippet abbreviations** preference. For more information, see “Setting Editors Preferences” on page 66.

---

**Customizing the Code Editor**

The Preferences window enables you to change several options that affect the features in the code editor, including autocompletion and color coding.

To access the editor options, select **Options > Preferences**. Click **Editors**.

For more information, see “Setting Editors Preferences” on page 66.
Chapter 3
Working with Data

About the Table Viewer

The table viewer is used to display your data in SAS Studio.
You can view the properties of the table and its columns by clicking **on the toolbar.

**Note:** You cannot view the properties of a password-protected table.
Opening and Viewing Data

You can open files in SAS Studio in several ways:

- You can double-click a file in the Explorer and Libraries sections.
- You can drag a file from the Explorer and Libraries sections to the work area.
• You can open a file by using a file reference in the **File References** section. You can open the file by double-clicking it or by dragging it to the work area.

**Note:** You cannot access password-protected data in SAS Studio.

**Note:** Files of type *.sas7bdat* are not supported in SAS Studio 5.1.

**Note:** If you open a table that was created with an encoding that has a different byte size than the encoding of your SAS compute server, you must use the CVP (character variable padding) engine in your LIBNAME statement. For more information, see *Avoiding Character Data Truncation by using the CVP Engine* in *SAS National Language Support (NLS): Reference Guide*.

When you open a table, the first 100 columns in the table are displayed by default. To specify which columns you want to include in the table viewer, click 📐 on the toolbar and select **Column selection**. You can use the Column Selection window to search for columns and to specify whether to show or hide specific columns in the data. Click 🔎 beside a column to toggle between showing and hiding the column. You can also select a column and then use the **Actions** menu to show and hide columns.

**Note:** The number of columns that can be displayed is determined by the **Columns displayed** option on the Tables page of the Preferences window. If you select more columns to display than the option specifies, the extra columns are displayed only after you change the value of the option. For more information, see “Setting Tables Preferences” on page 69.

By default, the column names are displayed, but you can choose to display the column labels by clicking 📐 on the toolbar and selecting **Show labels**.
Note: By default, the table viewer displays the total number of rows in the table and the total number of filtered rows, if you have filtered the data. However, if SAS Studio is unable to determine the row counts without affecting performance, then the row counts are listed as “Unavailable.”

**Viewing the Code That Is Used to Create a Table**

While you select options and customize the table to look the way you want it to, SAS Studio is generating SAS code that you can use. To view the code, click on the toolbar and select Generate code. A new program window appears with the code that was used to create the view of the table in the table viewer. The program is a copy of the code and is no longer associated with the original code. Editing the code does not affect the data that is displayed in the table viewer, and modifying the table viewer does not affect the contents of the code.
Opening Data in a Task from the Table Viewer

You can use the table viewer to open a task with the data that you are currently viewing. The task opens with the data automatically selected as the input source for the task. To open data in a task, click ☰️ on the toolbar and select Open in a task.
Refreshing Your Data

You can refresh the table viewer to update the data that is displayed in the table. When you refresh your data, you can choose to either reset any settings that you specified, or you can keep your settings.

To refresh the data and reset your settings, click on the table viewer toolbar and select Refresh > Table.

To refresh the data and keep your settings, click on the table viewer toolbar and select Refresh > Data.

Freezing and Sorting Data

In the table viewer, you can right-click a column heading to sort the data by that column or freeze the data at that column. You can sort the data in ascending or descending alphabetical order or display the columns in the order in which they appear in the data table.

To freeze a column so that column and any columns to the left remain visible while you scroll through the remaining columns, right-click the appropriate column and select Freeze column here. To add another column to the frozen section, right-click the column and select Move to freeze.
Filtering Data

You can filter your data in order to display only rows that meet certain criteria, based on values in the data. Click to use the Filter Table Rows window to create a filter expression. The Filter Table Rows window contains three main areas:

- **Data and Functions area** provides access to the columns in your data and the functions that you can use.
- **expression area** displays the expression as you build it. You can also type an expression in this area.
- **Values and Log area** the Values tab displays distinct values for columns. The Log tab displays the validation log.

You can add columns and functions to the expression by double-clicking the name. You can also add column names by right-clicking the column and selecting **Add to expression**. To populate a list of distinct values for the column, right-click the column and select **Get distinct values**. You can add values to the expression by double-clicking the value or right-clicking the value and selecting **Add to expression**.

**Note:** You can also type the expression directly in the expression box located above the table viewer.

To validate the syntax of your expression, click **Validate**. The Log tab displays any errors in your expression syntax.

**Note:** The option to validate your syntax is available only in the Standard perspective. For more information, see “Understanding Perspectives” on page 13.

**Note:** The = operator does not give expected results with decimal values. To create a filter with decimal values, use the Between operator.
Click OK to apply the expression to the data in the table viewer.
Exporting Data

In the Standard perspective, you can use SAS Studio to export your data as another file type to a folder that you specify.

Note: You cannot export password-protected data in SAS Studio, and you cannot export data from the Interactive perspective. For more information, see “Understanding Perspectives” on page 13.

To export your data:

1. Click Libraries in the navigation pane and browse to find the file that you want to export.
2. Right-click the file that you want to export and select Export. The Export Table window opens.
3. Select the folder in which you want to save the exported file.
4. In the Filename box, enter the name of the exported file.
   Note: You can also enter the full pathname of the file in the Filename box.
5. From the Type drop-down list, select the format of the exported file.
6. Click Save to export the file.

Note: When you export data, the entire file is exported. Any filters you might have applied to the data in the table viewer are not applied to the exported data.
Chapter 4
Working with Results

Viewing Results

When you run a task or a program in SAS Studio, the results are displayed in the work area. By default, results are generated as HTML5 output and displayed on the Results tab. Here are ways that you can work with your results:

• Add additional output formats, such as PDF, RTF, Excel, and PowerPoint, by using the Preferences window.

• Download your generated output. You can download results that have been created in any of the available formats.

• Change the default output style for each format by using the Preferences window.

Default SAS Studio Output

Viewing Default Results

In SAS Studio, by default, output is generated in HTML5.

If you want to add output formats, you can use the Preferences window to select other formats, such as PDF and RTF. You can also change the default style for your output to any of the ODS styles that are available. For more information, see “Setting the Results Preferences” on page 64.

By default, the HTML5 results are the only results that are displayed on the Results tab. When you view your results, you can use the table of contents to navigate the different
sections. By default, the table of contents is expanded, and you can click the section that you want to navigate to.

![SAS code editor and generated output]

**Downloading Generated Data**

You can download results that were generated in other formats, such as PDF or RTF, or as other types of data, such as a .csv or .xml file, by clicking ☐️ > Download and selecting the results that you want to download.

---

**About the SAS Output Delivery System**

The SAS Output Delivery System (ODS) gives you greater flexibility in generating, storing, and reproducing SAS procedure and DATA step output along with a wide range of formatting options. ODS provides formatting functionality that is not available when using individual procedures or the DATA step without ODS.

SAS Studio uses very specific ODS options and the GOPTIONS statements so that the output is displayed properly in the web environment. To view all of the ODS options in your code, click **Options > Preferences**. In the Preferences window, click **SAS Programs > Code and Log** and select the **Show generated code in the SAS log** option.

**Note:** To ensure that your output is displayed properly, do not change the settings of the ODS options or GOPTIONS statements in the generated code.
About SAS ODS Statistical Graphics

SAS ODS Statistical Graphics, more commonly referred to as SAS ODS Graphics, is an extension of the SAS Output Delivery System (ODS). ODS manages all output that is created by procedures and enables you to display the output in a variety of forms, including HTML and PDF.

Many SAS analytical procedures use ODS Graphics functionality to produce graphs. ODS Graphics uses the Graph Template Language (GTL) syntax, which provides the power and flexibility to create many complex graphs. The GTL is a comprehensive language for defining statistical graphics.

In SAS Studio, you can use the ODS Graphics Designer to define these statistical graphics without knowing the GTL. After a graph definition is created, you can use that graph definition to create an ODS statistical graph in SAS Studio.
Chapter 5

Understanding Tasks in SAS Studio

What Is a Task?

A task is an XML and Apache Velocity code file that generates SAS code and formats results for you. Tasks include SAS procedures from simple data listings to complex analytical procedures. SAS Studio is shipped with several predefined tasks that are available in the Standard perspective. The tasks are organized into categories. Some categories and their tasks might not be available at your site because you do not have the required SAS product.

For more information about each of these tasks, see SAS Studio: Task Reference Guide.

How to Run a Task

To run a predefined task:

1. In the navigation pane, click to open the Tasks pane.
2. Expand the folder that contains the task.
3. Right-click the task name and select Open. Alternatively, you can double-click the task to open it.

The task opens to the right of the work area.
4. If the Data tab is available, specify an input data source and select columns for the roles in the data source. A role is a description of a variable’s purpose in the task. To add a column to a role, click . A list of available columns for that role appears. If only one column can be assigned to the role, you select a column and the list disappears. If multiple columns can be assigned, you can press Ctrl or Shift to select multiple columns from the list and click OK.

5. On the remaining tabs, specify any other required options, which are denoted with a red asterisk. As you assign values to the task, the relevant SAS code is generated. For more information about the options available for each task, see SAS Studio: Task Reference Guide.

**TIP** The Task Console displays any information required to run the task.

6. To run the task, click .

---

**Edit a Predefined Task**

To customize the predefined tasks for your site, you can edit the XML code that is used to create the task.

To edit a predefined task:

1. In the navigation pane, click to open the Tasks pane.

2. Expand the folder that contains the task.

3. Right-click the name of the task that you want to edit and select Add to My Tasks. The Add to My Tasks window appears.

4. Specify a name and description for the task. By default, the name and description from the predefined task is used. You can also specify where to save a copy of this task in the My Tasks folder.
Click **OK**.

5. In the **My Tasks** folder, right-click the copied task and select **Edit**. The CTM file for the task appears in a new tab.

6. Edit the XML file and save your changes. To preview your changes, click **Open**.

---

**Create a New Task**

SAS Studio provides a template that you can use to create custom tasks for your site.

To create a custom task:

1. In the navigation pane, click **Tasks** to open the **Tasks** pane.

2. Click **Add** and select **Task**. A blank task template opens.

3. Edit the code in the task template to create your task. To view the user interface for the task template, click **Open**. In the user interface for the task template, you can see examples of radio buttons, check boxes, combination boxes, and other types of options. For more information about this file, see *SAS Studio: Developer’s Guide to Writing Custom Tasks*.

4. Click **Create a New Task**.

   *Note:* The name of the task cannot include these special characters:

   ```
   [ ] { } , ? / " # % * | < > : 
   ```
Specifying the Options for the Task Code

The Preferences window enables you to change several options that affect what and how the task code is displayed.

To access these options, select **Options** → **Preferences**. In the Preferences window, click **Tasks**.

For more information, see “Setting Task Preferences” on page 70.
Appendix 1

Customizing SAS Studio

About Customizing SAS Studio

You can customize SAS Studio by changing the global settings, such as theme and locale, and by specifying application preferences, such as code editor and table viewer options.

Creating Global Settings

About the Settings Window

The Settings window enables you to specify settings for the appearance theme, locale, and accessibility. To change the global settings, click the down arrow beside your name on the toolbar and select Settings.
Specifying the General Settings

From the General page, you can specify these options for SAS Studio.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Theme                            | Enables you to change the appearance of the SAS Studio web application. The theme specifies the collection of colors, graphics, and fonts that appear in the application. You can choose from SAS themes or custom themes, if you have any available. You can choose from these SAS themes: Illuminate  
  Includes a clean and uncomplicated color palette that is easy to use. This is the default theme. Inspire  
  Consists of vibrant and cohesive colors that shift the emphasis from the application to the content. High Contrast  
  Presents a dark background with high-contrast foreground elements to meet the needs of users with low vision. The theme change takes effect after you close the Settings window. Reset to show all warning and information messages | Displays warnings and messages that you previously chose to hide. Profile picture | Displays your profile picture. |

Specifying the Region and Language Settings

From the Region and Language page, you can specify these options.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locale for regional formats and sorting</td>
<td>Specifies the locale that is used for sorting data and formatting values such as dates, times, numbers, and currency. The default setting is the browser locale. Changes take effect after you sign out and sign back in.</td>
</tr>
<tr>
<td>Locale for offline processes</td>
<td>Specifies the locale that is used for offline jobs or background processes such as report distributions or notifications. The default setting is the locale of the Java Runtime Environment.</td>
</tr>
</tbody>
</table>
**Specifying the Accessibility Settings**

From the Accessibility page, you can specify these options.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable sounds</td>
<td>Enables audio indicators for events that occur within the user interface.</td>
</tr>
<tr>
<td>Enable visual effects</td>
<td>Adds visual effects that indicate state changes. For example, when this setting is enabled, you see a subtle movement in the user interface if you delete an item.</td>
</tr>
<tr>
<td>Invert application colors</td>
<td>Displays SAS Studio in inverted colors.</td>
</tr>
<tr>
<td>Display tooltips when using the keyboard to navigate</td>
<td>Displays the tooltips for each item in the application in a pop-up window as you navigate with the keyboard. You can specify where in the browser window you want to display the tooltips.</td>
</tr>
<tr>
<td>Customize the focus indicator settings</td>
<td>Enables you to customize the attributes of the outline that indicates which user interface component is active.</td>
</tr>
</tbody>
</table>

---

**Setting Your Preferences**

**About the Preferences Window**

The Preferences window enables you to customize several options in SAS Studio.

To change your preferences, select **Options > Preferences**.

**Setting the Start Up Preferences**

From the **Start Up** page, you can specify these options for starting SAS Studio.
Option to Open

Specifies the tabs to be displayed when you start the SAS Studio application. You can choose from these options:

- **Open a new program** opens a new program tab. This option is selected by default.

- **Restore tabs listed in Open Files pane** restores the tabs that were open in your prior session of SAS Studio. Any temporary files that were open are not restored.

  Note: The tabs are not necessarily restored in the same order they were in when you closed SAS Studio. Tabs that display a large amount of data can take longer to open and might be opened last.

- **None** starts SAS Studio with no tabs open in the work area.

### Setting General Preferences

From the **General** page, you can set these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display tab after submission</strong></td>
<td>Specifies the tab to display after you run a program or a task. You can choose to display the code, log, or results tabs. If you are running the Standard perspective, you can also choose to display output data tab. The Results tab is displayed by default.</td>
</tr>
<tr>
<td><strong>Display an Output tab when data is generated</strong></td>
<td>Automatically displays an output data tab when you submit a program or task that generates data.</td>
</tr>
<tr>
<td><strong>Display warning if text files are larger than specified size</strong></td>
<td>Displays a warning when you open a text file that is larger than the specified size in megabytes (MB). Text files include file types such as *.sas, *.txt, and *.csv. If you open a file that is larger than the specified size, the file is truncated and opened in read-only mode. The default size is 10 MB.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default text encoding</td>
<td>Specifies the character-set encoding that is used when text files, such as *.sas programs, are read or written. The default value is UTF-8. For a list of some of the encoding options and the languages that they are associated with, see Appendix 2, “Text Encoding Options and Language Mappings,” on page 71.</td>
</tr>
<tr>
<td>Enable document recovery</td>
<td>Enables you to recover the most recently saved version of your files if SAS Studio times out while you are away or closes unexpectedly due to a situation such as a power loss. If you select this option, the Document Recovery window opens when you restart SAS Studio, and you can choose the files that you want to recover. This option is selected by default. You can use the Document save interval option to specify how often you want to save your files. The default interval is 30 seconds.</td>
</tr>
</tbody>
</table>
| Automatically refresh libraries after each submission | Refreshes the Libraries section of the navigation pane after you submit a program, task, or query so that any changes to the libraries are displayed immediately. However, selecting this option can cause you to lose your place in the list of libraries and affect performance. This option is selected by default.  

*Note:* If you do not select this option and you submit code that creates a new file or library, you must click > Refresh to display the changes. If you create a new file or library using the SAS Studio user interface, those changes are displayed automatically even if this option is not selected.                                                                                                                                                                                                |
| Automatically refresh files and folders after each submission | Refreshes the Explorer section of the navigation pane after you submit a program, task, or query so that any changes to the files and folders are displayed immediately. However, selecting this option can cause you to lose your place in the list of files and folders and affect performance. This option is selected by default.  

*Note:* If you do not select this option and you submit code that creates a new file or folder, you must click > Refresh to display the changes. If you create a new file or folder using the SAS Studio user interface, those changes are displayed automatically even if this option is not selected.                                                                                                                                                                                                 |
### Setting the Code and Log Preferences

From the SAS Programs > Code and Log page, you can specify these options for the code and log tabs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear code on submit</td>
<td>Clears the code from the program window after you submit the code. This option is available only if you are running the Interactive perspective.</td>
</tr>
<tr>
<td>Show generated code in the SAS log</td>
<td>Displays the ODS statements, %LET statements, and any other code that is automatically generated by SAS in the log file. This option applies to both SAS tasks and SAS program files.</td>
</tr>
<tr>
<td>Generate errors, warnings and notes index</td>
<td>Creates a section at the top of the log that provides easy access to all of the errors, warnings, and notes in the log. When you click on a message, SAS Studio highlights it for you in the log so that you can see exactly where the message occurs in the log.</td>
</tr>
<tr>
<td>Stream log updates while a procedure is running</td>
<td>Displays log updates as a procedure is processed. If you do not select this option, the log is displayed when the procedure has finished running. This option is selected by default and might have a slight effect on performance. This option is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>Automatically clear log</td>
<td>Clears the log each time you submit code. This option is selected by default. If you do not select this option, then a Clear log button is available in the program editor. This option is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>Append log</td>
<td>Appends new log information to the existing log. You can choose to append the logs for programs, tasks, or both programs and tasks. This option is available only if you are running the Standard perspective.</td>
</tr>
</tbody>
</table>

### Setting the Results Preferences

From the Results page, you can specify these options.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display warning if results are larger than specific size</strong></td>
<td>Displays a warning message when you attempt to open a results file that is larger than the size that is specified in the <strong>Maximum size</strong> option. You can enter a value between 0.5 and 10 MB. The default value is 3 MB.</td>
</tr>
<tr>
<td><strong>Generate table of contents</strong></td>
<td>Creates a table of contents</td>
</tr>
<tr>
<td><strong>HTML output style</strong></td>
<td>Displays the style that is applied to results in HTML. To change the style that is applied to the results, select another style from the drop-down list.</td>
</tr>
<tr>
<td><strong>Generate HTML graphs as SVG</strong></td>
<td>Creates SVG graphs instead of PNG graphs in HTML output. SVG graphs maintain clarity when you zoom in and out.</td>
</tr>
</tbody>
</table>
| **Enable accessible graph option**              | Adds accessibility metadata to graphs that are created by ODS Graphics. Users with disabilities will access the accessibility metadata using SAS Graphics Accelerator. This option is available only if you are running SAS 9.4M4 or later. For more information, see the ODS HTML5 Statement in SAS Output Delivery System: User’s Guide.  
**Note:** The SAS code that is associated with this option is displayed in the log file only if you have selected the **Show generated code in the SAS log** option in the General preferences. |
| **Produce PDF output**                          | Generates results in PDF format. This option is not selected by default and is available only if you are running the Standard perspective.                                                          |
| **PDF output style**                            | Displays the style that is applied to results in PDF. To change the style that is applied to the results, select another style from the drop-down list. This option is available only if you are running the Standard perspective. |
| **Generate table of contents**                   | Creates a table of contents in the PDF file. This option is available only if you are running the Standard perspective.                                                                             |
| **Enable accessible PDF option**                | Adds accessibility metadata to the PDF file that enables the file to be accessed by assistive technology such as a screen reader. When metadata is added, the file is often called a "tagged PDF" and follows the PDF/Universal Accessibility (PDF/UA) format. This option is available only if you are running SAS 9.4M4 or later and the Standard perspective. |
### Option Descriptions

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Produce RTF output</td>
<td>Generates results in RTF format. This option is not selected by default and is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>RTF output style</td>
<td>Displays the style that is applied to results in RTF. To change the style that is applied to the results, select another style from the drop-down list. This option is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>Produce EXCEL output</td>
<td>Generates results in Microsoft Excel format. This option is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>Excel output style</td>
<td>Displays the style that is applied to results in Excel format. To change the style that is applied to the results, select another style from the drop-down list. This option is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>Produce PPT output</td>
<td>Generates results in Microsoft PowerPoint format. This option is available only if you are running the Standard perspective.</td>
</tr>
<tr>
<td>PPT output style</td>
<td>Displays the style that is applied to results in PowerPoint format. To change the style that is applied to the results, select another style from the drop-down list. This option is available only if you are running the Standard perspective.</td>
</tr>
</tbody>
</table>

**Note:** If you want to use a custom style, you must customize the SAS Studio output environment. For more information, see Appendix 3, “Customized Output Environment,” on page 73.

### Setting Editors Preferences

From the **Editors** page, you can set the options for the SAS and XML language editors.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable snippet abbreviations</td>
<td>Enables you to insert snippets into a program by entering <code>@snippet-name</code> or entering <code>@</code> and using the pop-up window to select from a list of snippets in your My Snippets folder. This option is selected by default. For more information, see “Create a Code Snippet” on page 38.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Editor Options</strong></td>
<td>Enables you to specify editing and display options as well as appearance options for the code editor. For more information, see “Setting General Code Editor Preferences” on page 67 and “Setting Code Editor Appearance Preferences” on page 68.</td>
</tr>
<tr>
<td><strong>Enable syntax highlighting</strong></td>
<td>Displays the text in the code editor in different colors to help you identify different elements in the syntax. This option is selected by default.</td>
</tr>
<tr>
<td><strong>Enable hint when you hover over keywords</strong></td>
<td>Displays the syntax help window when you position the mouse pointer over a valid SAS keyword in your program. If this option is not selected, then you can view the syntax help by right-clicking a keyword and selecting Syntax Help. This option is not selected by default.</td>
</tr>
</tbody>
</table>

### Setting General Code Editor Preferences

From the **Editors** page, click **Editor Options** and then click **Behavior and Appearance** to set editing and display options for the code editor.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show autocomplete list</strong></td>
<td>Turns on the autocomplete feature of the code editor. This feature can predict the next keyword that you want to type before you actually type it completely. For more information, see “Using the Autocomplete Feature” on page 20.</td>
</tr>
<tr>
<td><strong>Auto-indent</strong></td>
<td>Automatically indents a new line by the amount of space that the previous line is indented.</td>
</tr>
<tr>
<td><strong>Wrap text</strong></td>
<td>Displays text that continues past the right edge of the page on the next line.</td>
</tr>
<tr>
<td><strong>Use overtype mode</strong></td>
<td>Replaces existing characters with new characters when you type in the code editor.</td>
</tr>
<tr>
<td><strong>Auto-insert block comments</strong></td>
<td>Automatically inserts the closing comment tag when you enter /* and press Enter so that you can insert comments that span multiple lines.</td>
</tr>
<tr>
<td><strong>Auto-pair quotation marks</strong></td>
<td>Automatically inserts a closing quotation mark when you type a quotation mark and positions the cursor in between them.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto-pair brackets</td>
<td>Automatically inserts a closing bracket when you type a left bracket and positions the cursor in between them.</td>
</tr>
<tr>
<td>Highlight matching brackets</td>
<td>Highlights the matching bracket when you position the cursor on a bracket.</td>
</tr>
<tr>
<td>Enable code folding</td>
<td>Enables you to collapse and expand sections of code in the code editor.</td>
</tr>
<tr>
<td>Enable line highlighting</td>
<td>Automatically highlights the line of code you specify when you use the Go to line feature.</td>
</tr>
<tr>
<td>Show indent guides</td>
<td>Displays vertical lines that indicate where an indented section of code begins and ends.</td>
</tr>
<tr>
<td>Show line numbers</td>
<td>Displays line numbers in the leftmost column of the program tab.</td>
</tr>
<tr>
<td>Print line numbers</td>
<td>Includes line numbers in the leftmost column when you print a program.</td>
</tr>
<tr>
<td>Tab width</td>
<td>Specifies the number of spaces that are inserted into your text when you insert a tab character. The default value is four spaces for each tab character.</td>
</tr>
<tr>
<td>Substitute spaces for tabs</td>
<td>Inserts the number of spaces specified in the Tab width option instead of a single tab character.</td>
</tr>
</tbody>
</table>

**Setting Code Editor Appearance Preferences**

You can specify appearance options for both SAS code and XML code in the code editor. From the Editors page, click Editor Options and then click Colors and Fonts for SAS or Colors and Fonts for XML to set appearance options for the code editor.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax theme</td>
<td>Specifies whether to use a light or dark background in the code editor.</td>
</tr>
<tr>
<td>Font</td>
<td>Specifies the font that is used in the code editor.</td>
</tr>
<tr>
<td>Enable syntax highlighting</td>
<td>Enables you to specify the text style and background color of specific file elements in the code editor.</td>
</tr>
</tbody>
</table>
**Setting Tables Preferences**

From the Tables page, you can set the options for the table viewer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column headers</strong></td>
<td>Specifies whether column name or labels are displayed in the table viewer. Column names are displayed by default.</td>
</tr>
<tr>
<td><strong>Rows per page</strong></td>
<td>Specifies the number of rows to display per page of data. The default value is 200.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> You can override this option for an open table in the table viewer by clicking <strong>Row paging</strong> on the table viewer toolbar and selecting <strong>Row paging</strong>.</td>
</tr>
<tr>
<td><strong>Columns displayed</strong></td>
<td>Specifies the maximum number of columns to display in the table viewer. The default value is 100. Increasing the number of columns that are displayed might affect your performance.</td>
</tr>
<tr>
<td><strong>SAS variable name policy</strong></td>
<td>Enables you to specify one of the following sets of rules to apply to SAS variable names. Any changes you make to this option take effect when you start SAS Studio or reset your SAS session.</td>
</tr>
<tr>
<td></td>
<td>• <strong>ANY</strong> specifies that the variable names can begin with or contain any characters, including blanks, must contain at least one character, and cannot contain any null bytes. Variable names can contain mixed-case letters as well as special and multi-byte characters. Names can be up to 32 bytes in length. This option is selected by default. Leading blanks are preserved, but trailing blanks are ignored.</td>
</tr>
<tr>
<td></td>
<td>• <strong>V7</strong> specifies that the variable names must begin with a letter of the Latin alphabet (A-Z, a-z) or the underscore character. They cannot contain blanks or special characters except for the underscore and cannot be assigned the names of special SAS automatic variables or variable list names. Variable names can contain mixed-case letters and can be up to 32 bytes in length.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
SAS member name policy | Enables you to specify one of the following sets of rules to apply to SAS data set names, SAS data view names, and item store names. Any changes you make to this option take effect when you start SAS Studio or reset your SAS session.

- **EXTEND** (Extended member names) specifies that names must contain at least one character (letters, numbers, valid special characters, and national characters), cannot begin with a blank or a period, and cannot include a null byte. Names can contain mixed-case letters and can be up to 32 bytes in length. Leading blanks are preserved, but trailing blanks are ignored. This option is selected by default.

- **COMPATIBLE** (Basic member names) specifies that the names must begin with a letter of the Latin alphabet (A-Z, a-z) or the underscore character and cannot contain blanks or special characters except for the underscore. Names can contain mixed-case letters and can be up to 32 characters in length.

### Setting Task Preferences

From the **Tasks** page, you can set the options for the generated SAS code and the task layout in the SAS Studio workspace. These options are available only if you are running the Standard perspective.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate header comments for task code</td>
<td>Adds comments before the generated code for a SAS task.</td>
</tr>
<tr>
<td>Automatically format generated code</td>
<td>Automatically formats any code that is generated by a task.</td>
</tr>
</tbody>
</table>
# Text Encoding Options and Language Mappings

The following table lists some of the text encoding options and the languages they are associated with. For more information, see “Setting General Preferences” on page 62.

<table>
<thead>
<tr>
<th>Text Encoding Option</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows-1250</td>
<td>(Central European languages): Polish, Czech, Slovak, Hungarian, Slovenian, Serbian Latin, Croatian, Bosnian, Romanian, Albanian</td>
</tr>
<tr>
<td>Windows-1251</td>
<td>(Cyrillic languages): Russian, Byelorussian, Bulgarian, Serbian Cyrillie, Macedonian, Ukrainian</td>
</tr>
<tr>
<td>Windows-1252</td>
<td>(Western European languages): Afrikaans, Basque, Catalan, Valencian, Welsh, Danish, German, English, Spanish, Basque, Finnish, Faroese, French, Western Frisian, Irish, Galician, Indonesian, Icelandic, Italian, Inuktitut, Luxembourgish, Malay, Norwegian Bokmål, Dutch, Norwegian Nynorsk, Portuguese, Quechua, Romansh, Northern Sami, Swedish, Swahili, Tswana, Xhosa, Zulu</td>
</tr>
<tr>
<td>Windows-1253</td>
<td>Greek</td>
</tr>
<tr>
<td>Windows-1254</td>
<td>Turkish</td>
</tr>
<tr>
<td>Text Encoding Option</td>
<td>Language</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Windows-1255</td>
<td>Hebrew</td>
</tr>
<tr>
<td>Windows-1256</td>
<td>Arabic</td>
</tr>
<tr>
<td>Windows-1257</td>
<td>(Baltic languages): Estonian, Latvian, Lithuanian</td>
</tr>
<tr>
<td>Windows-1258</td>
<td>Vietnamese</td>
</tr>
</tbody>
</table>
Appendix 3

Customized Output Environment

Overview

You must customize the SAS Studio output environment to perform any of these tasks:

• generate output for other output destinations
• send your results to another location
• use a custom style for your output
• use an image format other than the default
• create a drill-down graph
• create an animated GIF or SVG image

To customize the SAS Studio output environment, first disable the default output environment in order to conserve system resources. Next, establish your own output environment, and then execute the SAS statements that are required to generate your output. Use ODS statements, ODS procedures, or ODS options in your SAS program to define the environment that you need.

As a best practice, if your SAS program requires a customized output environment in SAS Studio, your program should always perform these steps:

1. Create a file reference for your ODS output. You can use the &_SASWS_ macro variable that is defined in SAS Studio to reference your home directory as shown in the following statement:

   filename odsout "&_SASWS_/charts";
If you want to store your image files in a separate directory, create a second file reference for your image files as shown in the following statement:

```plaintext
filename ods1out "&_SASWS_/charts/images";
```

*Note:* The directories that you specify must already exist, and you must have Write access to the directories.

2. To conserve system resources, disable the default output environment by using the following statement:

```plaintext
ods _all_ close;
```

3. Open the desired ODS destination. Use the PATH= option to specify the file reference that you created for your ODS output. If you created a separate file reference for your image files, use the GPATH= option to specify the image output file reference. Here is an example:

```plaintext
ods html path=odsout gpath=ods1out file="saleschart.html";
```

4. Execute the SAS statements that are required to generate your output.

5. Close your ODS destination.

When you disable the default SAS Studio output environment, results are no longer displayed on the **Results** tab for the duration of your program. The results are generated only by the ODS destination that you open.

---

### Generate Output for Other Output Destinations

If you need to generate output other than the default HTML5, PDF, or RTF output, you must open your own ODS destination. Examples of output destinations include HTML, PowerPoint, and LISTING. After you disable the default output environment, use an ODS statement to open your own output destination. Here is an example:

```plaintext
filename odsout "&_SASWS_/charts";
ods _all_ close;
ods powerpoint path=odsout file="filename";
```

To access the dictionary of ODS statements, see *SAS Output Delivery System: User’s Guide*.

---

### Send Your Results to Another Location

When you execute a program in SAS Studio, you can download the output from the **Results** tab to your local machine. If you want to send your output directly to another location, you must open your own ODS destination. By default, output files that are generated by the ODS destinations that you open are written to your home directory.

If you want to send the results to a specific location, use a FILENAME statement to define a file reference to the desired location. You can use the &_SASWS_ macro variable to reference your home directory. After you create the file reference, use the PATH=**file-reference** option in your ODS statement. Here is an example:

```plaintext
filename odsout "&_SASWS_/charts";
ods _all_ close;
ods html path=odsout file="sales.htm";
```
In this case, file sales.htm and any image files that are generated are written to subdirectory <code>charts</code> in your home directory.

---

### Use a Custom Style for Your Output

When you need to use a custom ODS style such as a corporate style for your results in SAS Studio, you must open your own ODS destination. You cannot specify a custom style for the default results. Use the `STYLE=` option in your ODS statement to specify your custom style. Here is an example:

```sas
filename odsout ="&_SASWS_/charts*;
ods _all_ close;
ods html path=odsout file="filename.htm" style=style-name;
```

To create a custom style, use the ODS TEMPLATE procedure, CSSStyles, or the `STYLE=` option. For more information, see <i>SAS Output Delivery System: User’s Guide</i>.

---

### Use an Image Format Other Than the Default

When you need to use an image format other than the default, you must specify the desired output format, and then open your own ODS destination. To specify the image format:

- If you are using SAS/GRAPH to create your graphs, specify the `DEVICE=` option in an OPTIONS or GOPTIONS statement. For more information, see <i>SAS/GRAPH: Reference</i>.

  **Note:** The ACTIVEX and JAVA graphics output devices are not recommended in SAS Studio 5.1. Your graphs might not work as expected if you use these output devices.

- If you are using ODS Graphics to create your graphs, specify the `OUTPUTFMT=` option in an ODS GRAPHICS statement. For more information, see <i>SAS Output Delivery System: User’s Guide</i>.

---

### Create a Drill-down Graph

When you need to create a drill-down graph in SAS Studio, you must open your own ODS destination. Drill-down graphs provide a convenient means for users to explore complex data. In a drill-down graph, certain elements of the graph contain active links. When a user clicks a linked element, the linked resource appears in a new browser window by default.

For more information, see the following documents:

- If you are using SAS/GRAPH to create the graph, see <i>SAS/GRAPH: Reference</i>.

- If you are using the Graph Template Language to create the graph, see <i>SAS Graph Template Language: User’s Guide</i>.
Create an Animated GIF or SVG Image

When you need to create an animated graph in SAS Studio, you must open your own ODS destination. An animated graph displays a series of charts automatically when the graph is viewed in a web browser or other viewer that supports animation. The animation plays as a sequence of graphs in a slide-show fashion with a delay between each graph. The sequence can play only one time, loop a fixed number of times and then stop, or loop indefinitely.

For more information, see the following documents:

- If you are using SAS/GRAPH to create the graph, see *SAS/GRAPH: Reference*.
- If you are using the Graph Template Language to create the graph, see *SAS Graph Template Language: User’s Guide*. 
Appendix 4
Keyboard Shortcuts

Keyboard Shortcuts in SAS Studio Workspace

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut for Microsoft Windows</th>
<th>Keyboard Shortcut for Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in.</td>
<td>Ctrl+ plus sign</td>
<td>Cmd+ plus sign</td>
</tr>
<tr>
<td>Note: When you zoom into SAS Studio, no scroll bars are displayed for the browser window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom out.</td>
<td>Ctrl+ minus sign</td>
<td>Cmd+ minus sign</td>
</tr>
<tr>
<td>Reset the zoom state.</td>
<td>Ctrl+0</td>
<td>Cmd+0</td>
</tr>
<tr>
<td>Toggle the fullscreen view on and off.</td>
<td>Alt+F11</td>
<td>Fn+Shift+F11</td>
</tr>
<tr>
<td>Toggle the Console window on and off.</td>
<td>Alt+C</td>
<td>Option+C</td>
</tr>
<tr>
<td>Open a pop-up menu in the navigation pane.</td>
<td>Select an item, and press Shift +Alt+F10.</td>
<td>Select an item, and press Fn +Shift+F10.</td>
</tr>
<tr>
<td>Navigate to the top node at the current level in the navigation pane.</td>
<td>Home</td>
<td>Fn+ left arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut for Microsoft Windows</td>
<td>Keyboard Shortcut for Mac OS X</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Navigate to the topmost node in the current section of the navigation pane.</td>
<td>Ctrl+Home</td>
<td>Ctrl+Fn+left arrow</td>
</tr>
<tr>
<td>Navigate to the bottom node at the current level in the navigation pane.</td>
<td>End</td>
<td>Fn+right arrow</td>
</tr>
<tr>
<td>Navigate to the bottom node in the current section of the navigation pane.</td>
<td>Ctrl+End</td>
<td>Fn+left arrow</td>
</tr>
<tr>
<td>Create a new SAS program.</td>
<td>F4</td>
<td>Fn+F4</td>
</tr>
<tr>
<td>Save the SAS program.</td>
<td>Ensure that the Code tab for a SAS program is displayed, and press Ctrl+S.</td>
<td>Ensure that the Code tab for a SAS program is displayed, and press Cmd+S.</td>
</tr>
<tr>
<td>Run the code.</td>
<td>Ensure that a Code tab is displayed, and press F3 or F8.</td>
<td>Ensure that a Code tab is displayed, and press F3 or F8.</td>
</tr>
<tr>
<td>Note: In JAWS, F3 is the keyboard shortcut for the find functionality. Therefore to run SAS code, you first must press Insert+3 and then press F3. Alternatively, turn off the JAWS virtual PC cursor by pressing Insert+Z.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset the SAS session.</td>
<td>F9</td>
<td>Fn+F9</td>
</tr>
<tr>
<td>Note: When you reset the SAS session, all libraries and file shortcuts that you created during the current session are deleted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save the log or results file.</td>
<td>Ensure that the Log or Results tab is displayed, and press Ctrl+S.</td>
<td>Ensure that the Log or Results tab is displayed, and press Cmd+S.</td>
</tr>
<tr>
<td>Print the SAS program, log, or results.</td>
<td>Ctrl+P</td>
<td>Cmd+P to open the content in a new tab. Then press Cmd+P again to print the content.</td>
</tr>
<tr>
<td>Move the focus to the button for the active section of the navigation pane. Use Tab and Shift+Tab to navigate among the buttons, and press Enter to open the selected section.</td>
<td>Alt+1</td>
<td>Option+1</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut for Microsoft Windows</td>
<td>Keyboard Shortcut for Mac OS X</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Move the focus to the next secondary tab.</td>
<td>Alt+2</td>
<td>Option+2</td>
</tr>
<tr>
<td>In a program window, the secondary tabs are Code, Log, or Results.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move the focus to the next primary tab in the work area.</td>
<td>Alt+3</td>
<td>Option+3</td>
</tr>
<tr>
<td>Move the focus to the body of the Code tab on the currently displayed primary tab.</td>
<td>Alt+4</td>
<td>Option+4</td>
</tr>
<tr>
<td>Move the focus to the selected item in the Log tab on the currently displayed primary tab.</td>
<td>Alt+5</td>
<td>Option+5</td>
</tr>
<tr>
<td>Move the focus to the Results tab.</td>
<td>Alt+6</td>
<td>Option+6</td>
</tr>
<tr>
<td>Move the focus to the output data tab, if one exists, on the currently displayed primary tab.</td>
<td>Alt+7</td>
<td>Option+7</td>
</tr>
<tr>
<td>Move the focus to the first button on the toolbar of the currently displayed tab.</td>
<td>Ctrl+Alt+1</td>
<td>Cmd+Option+1</td>
</tr>
<tr>
<td>Navigate through items in the navigation pane and the SAS Studio workspace.</td>
<td>Tab, Shift+Tab</td>
<td>Tab, Shift+Tab</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts for the Code Editor**

This table contains keyboard shortcuts for the code editor in SAS Studio.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut for Microsoft Windows</th>
<th>Keyboard Shortcut for Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a pop-up menu in the code editor.</td>
<td>Shift+F10</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Note: In Microsoft Edge, use Shift+Alt+F10 to open a pop-up menu.</td>
<td></td>
<td>Note: On some Apple Mac systems, you might need to press Shift+Fn+F10 to open a pop-up menu.</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut for Microsoft Windows</td>
<td>Keyboard Shortcut for Mac OS X</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create a new snippet from SAS code.</td>
<td>In the code editor, select the code and press Alt+A.</td>
<td>In the code editor, select the code and press Cmd+ Option +A.</td>
</tr>
<tr>
<td><strong>Note:</strong> The snippet is saved to your My Snippets folder.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert an existing snippet.</td>
<td>Alt+I</td>
<td>Cmd+Option+I</td>
</tr>
<tr>
<td>Add or remove comment tags for SAS code in the code editor.</td>
<td>Ctrl+/</td>
<td>Cmd+/</td>
</tr>
<tr>
<td>In the code editor, display the currently applicable list of SAS keywords (autocomplete feature).</td>
<td>Ctrl+Spacebar (This shortcut also navigates to the next list if more than one is available.)</td>
<td>Control+Spacebar (This shortcut also navigates to the next list if more than one is available.)</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Shift+Spacebar (This shortcut also navigates to the previous list if more than one is available.)</td>
<td>Control+Shift+Spacebar (This shortcut also navigates to the previous list if more than one is available.)</td>
</tr>
<tr>
<td><strong>Note:</strong> These shortcuts do not work when JAWS is on.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you use Ctrl +Spacebar to switch the input method editor (IME) in Windows, complete these steps to use a different shortcut for switching the IME:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• First, in the region and language options of the Control Panel, select the option for changing your keyboard or input method.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Next, select the option or button for changing your keyboard.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Then, in the advanced key settings section, select the row that contains the Ctrl +Spacebar key sequence and change it to use a different shortcut.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Finally, restart any application that needs to use the new shortcut. (You might need to also restart your computer.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut for Microsoft Windows</td>
<td>Keyboard Shortcut for Mac OS X</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Navigate between an autocomplete list and its associated Help pop-up</td>
<td>Tab, Shift+Tab</td>
<td>Tab, Shift+Tab</td>
</tr>
<tr>
<td>window in the code editor.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select all text in the code editor.</td>
<td>Ctrl+A</td>
<td>Cmd+A</td>
</tr>
<tr>
<td>Copy text in the code editor.</td>
<td>Ctrl+C</td>
<td>Cmd+C</td>
</tr>
<tr>
<td>Cut text in the code editor.</td>
<td>Ctrl+X</td>
<td>Cmd+X</td>
</tr>
<tr>
<td>Paste text in the code editor.</td>
<td>Ctrl+V</td>
<td>Cmd+V</td>
</tr>
<tr>
<td>Undo an action in the code editor.</td>
<td>Ctrl+Z</td>
<td>Cmd+Z</td>
</tr>
<tr>
<td>Redo an action in the code editor.</td>
<td>Ctrl+Y</td>
<td></td>
</tr>
<tr>
<td>Find and replace text in the code editor.</td>
<td>Ensure that the focus is in the body</td>
<td>Ensure that the focus is in</td>
</tr>
<tr>
<td>of the code editor, and then press Ctrl+F.</td>
<td>of the code editor, and then press</td>
<td>the body of the code editor,</td>
</tr>
<tr>
<td></td>
<td>Cmd+F</td>
<td>and then press Cmd+F.</td>
</tr>
<tr>
<td>Move the cursor to the beginning of the word on the left of the</td>
<td>Ctrl+left arrow</td>
<td>Option+left arrow</td>
</tr>
<tr>
<td>cursor.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move the cursor to the beginning of the word on the right of the</td>
<td>Ctrl+right arrow</td>
<td></td>
</tr>
<tr>
<td>cursor.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move the cursor to the end of the word on the right of the cursor.</td>
<td>Option+right arrow</td>
<td></td>
</tr>
<tr>
<td>Move the cursor to the beginning of the previous paragraph.</td>
<td>Option+up arrow</td>
<td></td>
</tr>
<tr>
<td>Move the cursor to the beginning of the next paragraph.</td>
<td>Option+down arrow</td>
<td></td>
</tr>
<tr>
<td>Go to specified line.</td>
<td>Ctrl+G</td>
<td>Cmd+G</td>
</tr>
<tr>
<td>Scrolls the editor (if you are using a browser other than Microsoft</td>
<td>Ctrl+down arrow, Ctrl+up arrow</td>
<td></td>
</tr>
<tr>
<td>Edge, the cursor does not move).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut for Microsoft Windows</td>
<td>Keyboard Shortcut for Mac OS X</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>----------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Scrolls a page down or up (moves cursor).</td>
<td>Page Down, Page Up</td>
<td>Page Down, Page Up</td>
</tr>
<tr>
<td>Note: If you are not using the full extension keyboard, use Fn+down and Fn+up to page down and page up.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move the cursor to the end of the line.</td>
<td>End</td>
<td>Cmd+right arrow</td>
</tr>
<tr>
<td>Move the cursor to the beginning of the line.</td>
<td>Home</td>
<td>Cmd+left arrow</td>
</tr>
<tr>
<td>Move the cursor to the top of the document.</td>
<td>Ctrl+Home</td>
<td>Cmd+up arrow</td>
</tr>
<tr>
<td>Move the cursor to the bottom of the document.</td>
<td>Ctrl+End</td>
<td>Cmd+down arrow</td>
</tr>
<tr>
<td>Select (highlight) text to the left of the cursor character-by-character.</td>
<td>Shift+left arrow</td>
<td>Shift+left arrow</td>
</tr>
<tr>
<td>Select (highlight) text to the right of the cursor character-by-character.</td>
<td>Shift+right arrow</td>
<td>Shift+right arrow</td>
</tr>
<tr>
<td>Select (highlight) text from the cursor to the same location on the previous line.</td>
<td>Shift+up arrow</td>
<td>Shift+up arrow</td>
</tr>
<tr>
<td>Select (highlight) text from the cursor to same location on the next line.</td>
<td>Shift+down arrow</td>
<td>Shift+down arrow</td>
</tr>
<tr>
<td>Delete the word on the left of the cursor.</td>
<td>Ctrl+Backspace</td>
<td>Option+Delete (backward)</td>
</tr>
<tr>
<td>Note: If your keyboard does not contain a key for deleting backward, then press Fn +Delete.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete the word on the right of the cursor.</td>
<td>Ctrl+Delete</td>
<td>Option+Delete (forward)</td>
</tr>
<tr>
<td>Note: If your keyboard does not contain a key for deleting forward, then press Fn +Delete.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete the current line.</td>
<td>Cmd+Delete</td>
<td>Cmd+Delete (backward)</td>
</tr>
<tr>
<td>Note: If your keyboard does not contain a key for deleting backward, then press fn +delete.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts for the Expression Builder

This table contains keyboard shortcuts for the expression builder in the Filter Table Rows window.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut for Microsoft Windows</th>
<th>Keyboard Shortcut for Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the focus to the first button on the expression editor toolbar.</td>
<td>Ctrl+Alt+T</td>
<td>Cmd+Option+T</td>
</tr>
<tr>
<td>Move the focus to the Values tab.</td>
<td>Ctrl+Alt+V</td>
<td>Cmd+Option+V</td>
</tr>
<tr>
<td>Move the focus to the Log tab.</td>
<td>Ctrl+Alt+L</td>
<td>Cmd+Option+L</td>
</tr>
</tbody>
</table>
Recommended Reading

- *Getting Started with Programming in SAS Studio*
- *The Little SAS Book: A Primer* (Buy)
- *SAS Statistics by Example* (Buy)
- *Elementary Statistics Using SAS* (Buy)

For a complete list of SAS publications, go to sas.com/store/books. If you have questions about which titles you need, please contact a SAS Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-0025
Fax: 1-919-677-4444
Email: sasbook@sas.com
Web address: sas.com/store/books
Index

A
abbreviation                   creating for snippets 38
accessibility settings         61
accessible graph               65
accessible PDF                 65
autocomplete                   20
autoexec file                  14

B
brackets                       matching 24

C
code                           editing from a task 25
                                   formatting SAS code 27
                                   selecting a column 24
                                   showing in the SAS log 64
code and log preferences       64
code editor                     about 17
                                   autocomplete 20
                                   color coding 67
                                   customizing 39, 66
                                   keyboard shortcuts 79
                                   specifying font 68
                                   substituting spaces for tabs 68
                                   syntax help window 67
                                   tab width 68
code editor appearance preferences 68
code snippets                   29
column                          selecting in a program 24
Column Selection window        43
exporting                      50
filtering                      48
freezing                       47
opening                        43
refreshing                     47
showing labels                 43
sorting                        47
table viewer                   41
document recovery option       62

E
editor preferences             39
editors preferences            66
encoding                       
                                   opening a program with 18
                                   saving a program with 20
Explorer section of the navigation pane 3
exporting data                 50
expression builder             48
                                   keyboard shortcuts 83

F
File Shortcuts section of the navigation pane 6
filtering data                 48
folder shortcuts               3
formatting SAS code            27
freezing data                  47
fullscreen view                8

general code editor preferences 67
general preferences            62
general settings               60
global settings                59

H
hints                           code editor 67
I
interactive perspective 28
Interactive perspective 13

K
keyboard shortcuts
  code editor 79
  expression builder 83
  workspace 77

L
libraries
  using to add table and column names 24
Libraries section of the navigation pane 5
log
  stream updates 64
logs
  displaying line numbers 68

M
macro variables 26
matching parentheses 24
maximizing the work area 8
My Tasks folder 56

N
navigation pane 3
  about 3
  customizing 7
Explorer 3
File Shortcuts 6
Libraries 5
Open Files 3
Snippets 5
Tasks 4

O
ODS (SAS Output Delivery System) 52
Open Files section of the navigation pane 3

P
parentheses
  matching 24
pathname
  inserting in a program 24

PDF output 65
  enable accessible PDF 65
  table of contents 65
  perspectives 13
  preferences
    code and log 64
    code editor appearance 68
    editor 39
    editors 66
    general 62
    general code editor 67
    results 64
    setting 61
    start up 61
    tables 69
    tasks 58, 70
Preferences window 61
program package 25
program summary 26
programs
  autocomplete 20
  creating 19
  displaying line numbers 68
  formatting 27
  go to line 18
  inserting a pathname 24
  interactive perspective 28
  opening 18
  running 19
  saving 20
  selecting a column 24
  syntax help 22

R
refreshing your data 47
region and language settings 60
resetting your SAS session 15
results
  changing styles 64
  downloading generated data 52
  HTML output 65
  PDF output 65
  RTF output 66
  viewing 51
results preferences 64
RTF output 66

S
SAS ODS Graphics 53
SAS Output Delivery System (ODS) 52
SAS program package 25
SAS program summary 26
SAS session
  resetting 15
searching in SAS Studio 9
selecting a column of text 24
settings
  accessibility 61
  general 60
  global 59
  region and language 60
snippets
  about 29
  creating 38
  inserting 38
  using an abbreviation 38
Snippets section of the navigation pane 5
snippets
  creating an abbreviation 38
sorting data 47
Standard perspective 13
Start Up preferences 61
stream log updates 64
submission history 27
Submission Status window 12
syntax help 22
syntax help window 67

tab characters
  number of spaces 68
  tab width 68
  code editor 68

  table filtering 48
  opening in a task 46
  table viewer 41
  refreshing 47
  tables
  displaying the generated code 45
  opening 43
  resizing column widths 43

  tables preferences 69
  tabs
    rearranging in the workspace 8
  task
    open with data from the table viewer 46
  task code
    adding comments 58, 70
    formatting 58, 70
  tasks
    about 55
    adding comments before generated code 70
    creating 57
    editing 56
    editing the generated code 25
    formatting generated code 70
    running 55
  tasks preferences 70
  Tasks section of the navigation pane 4
text file
  creating 19

  warnings
    opening large files 65
  work area 7
    customizing 8
    rearranging tabs 8
  workspace
    keyboard shortcuts 77

XML file
  creating 19
XML templates 57
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.